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About this Guide
This Quick Start Guide introduces you to Eze EMS (Execution Management System) and describes the key 
features and components you will likely use in a typical trading day. While this guide is not exhaustive, it 
is designed to help you rapidly get up to speed with Eze EMS. 

The primary goal of this guide is to assist you in learning the basics of Eze EMS and gain proficiency in:

 l Understanding the purpose of the EMS, its main features, and business value.

 l Accessing Eze EMS, understanding the workspace, and how it can be customized.

 l Using Eze EMS to access market data tools to inform order routing.

 l Creating and routing orders.

 l Monitoring market performance.

For your reference, common use cases are included that illustrate the capabilities of Eze EMS. 

Audience
This guide is intended to be used by:

 l Buy-side traders who have a solid understanding of the financial services domain, investment con-
cepts with knowledge of assets, the stock market, and trading.

 l Those who would like an introduction to Eze EMS. 
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Eze EMS Overview
Eze EMS is a high-speed, multi-broker execution management system that provides centralized access to 
liquidity venues for execution and tools for dynamically managing positions, portfolios, and trading risk 
across global equity, futures, and options markets.

Highlights of Eze EMS features include:  

 l Global connectivity to liquidity sources such as exchanges, brokers, ECN’s/MTF’s, and dark pools. 
Eze EMS supports over 200+ brokers on its network.

 l Ability to consolidate applications on the desktop and use one global ‘portal’ for trading multiple 
asset classes including Equities, Futures, Options, FX, ETF’s and CFD’s.

 l Ability to use real-time data, Eze EMS Market Data, or third-party market data (Bloomberg Desktop 
API).

 l Seamless integration with in-house systems via FIX or API's to facilitate straight-through processing 
of trades to minimize operational risk.

 l Sophisticated trading tools to analyze (market data, charting, news), execute (broker algorithms, 
program trading, pairs trading, spreads trading), and evaluate trades (TCA – Transaction Cost Ana-
lysis).

Order Origination
There are several different ways to get orders into Eze EMS. An order can either be generated internally 
within Eze EMS, or it can flow in from a variety of different external applications, including Microsoft 
Excel, Eze EMS API, and an Order Management System (OMS). A few methods of order entry however, 
are more prominent than others. 

Many users choose to stage in orders from an OMS into Eze EMS. While Eze OMS is a viable solution, 
most OMS systems can be configured to connect with Eze EMS. Once the orders are staged into the 
system through FIX, they appear on the blotter ready to be acted upon. Some users enable claiming, 
which adds the ability for traders to declare their intentions of working the order before another trader 
picks it up.

Eze EMS also acts as a standalone system to create and work orders. You can enter orders into Eze EMS 
and directly send them out to the market. As an alternative, you can “stage” an order within Eze EMS to 
create the trade internally without sending it to the market. This is frequently done when a trader knows 
what they want to trade but is still determining where to send the order. Once an order is staged, you 
can choose to send the order to market using any of the routing methods provided by Eze EMS.

Market Data Tools
After the orders have been staged and are available on the blotter, you can use a wide variety of tools to 
help perform pre-trade Transaction Cost Analysis (TCA). These tools can help you decide when it is best 
to send an order to the market and where you should send the order to.
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The majority of the trading tools within Eze EMS are supported by market data. Real-time market data is 
available through Eze EMS Market Data, Bloomberg Desktop API, or a combination of both. Some of the 
most popular tools for analysis are Time & Sales, Charts, and MarketMakers windows. These windows 
allow you to view historical and current market performance for an asset or group of assets before 
making decisions on when and where to route the order.

Routing and Order Execution Options
Eze EMS offers several methods for routing and executing orders. It connects to several liquidity sources, 
such as over 200+ brokers, exchanges and darkpools. The ability for a trader to access each option is 
controlled by a set of route permissions that are assigned internally by an Eze employee.

One type of route directs orders to a cash desk where a human with market expertise picks up the trade 
and executes it according to specified parameters. There is also Direct Market Access (DMA), where the 
Buy Side leverages the Sell Side infrastructure to access the market and execute the order. Algo routes 
are also available to users. These routes allow the order to be sent and executed by an algorithm defined 
by a brokerage. Each order can be split and sent to multiple routes for execution.

Monitoring Order Status
Once the orders are sent out, you can monitor the status of orders as they fill.  You can create multiple 
types of Market Minders to view the orders in a blotter. These configurations allow for a customized 
display, depicting only what you want to see. For example, an Order Blotter only shows orders that have 
been sent out, while a List Trader shows the staged orders and any “children” executed off of the staged 
order. Each type of display shows important information about the executions, such as executed amount, 
price, and current status.

In addition to actively monitoring blotters, you can set up alerts that are triggered when certain 
conditions are met. Some commonly-used conditions include: when orders are created, fully filled, or are 
canceled. These alerts are configured within Eze EMS and can present themselves as pop-up windows, 
color changes within screens, or sounds. You can choose to receive alerts only pertaining to your orders 
or to anyone within your firm.

End-of-Day Reporting and Reconciliation
After the market closes and you are done trading, Eze EMS can generate reports of the trades based on a 
given parameter list.  These reports are generated by querying data from the databases and are sent out 
to clients or other third parties. Typical uses of these files include clearing purposes, reconciliation, and 
post-trade TCA.
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Getting Started
Eze EMS is a secure platform comprised of numerous customizable and out-of-the-box components and 
options. This section provides introductory information, such as how to access Eze EMS, work with 
different types of accounts, the Eze EMS workspace and how to customize it, and the basic features of 
Eze EMS.

Accessing Eze EMS
Eze EMS is a secure platform that requires you to login to gain access to the functionality of the 
application. The first time you login to your Eze EMS account, enter the user name, domain, and 
password as provided by your SS&C Eze client service representative.

Note: Multi-Factor Authentication (MFA) is available for Eze EMS, providing you with an 
additional security layer during Eze EMS and RealTick Extra login. For more information, refer 
to Multi-Factor Authentication in Eze EMS and RealTick Extra.

Logging into Eze EMS
To log into Eze EMS:

 1. Double-click the Eze EMS icon on your desktop. Alternatively, navigate to Eze EMS from the Start 
menu.

 2. Enter your User Name, Domain, Password, and Locale in the login window, shown below.
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Note: After the first login, you only need to enter your password for subsequent 
logins. If you have the AutoLogon permission added to your account, select the 
AutoLogon Next Time checkbox on the login window, and you will not be prompted to 
enter your information the next time you login.

 3. Click OK. 

 4. A green lock  appears in the system tray.             

Changing Eze EMS Login Password
Eze EMS allows you to change your password after the first login.

To change your password:

 1. Right-click the green lock in the system tray and select Change Password. The Change Password 
window appears, as shown below.

 2. Enter your current password in the Old Password field.

 3. Enter a password of your choice in the New Password field, retype the same password in the 
Confirm Password field, and then click OK.

Multi-Factor Authentication in Eze EMS and RealTick Extra
Eze EMS can be configured with Multi-Factor Authentication (MFA), also called Two-Factor 
Authentication (2FA), providing an additional security layer during Eze EMS and RealTick Extra login and 
increased protection against non-privileged users.

Eze EMS Quick Start Guide | © 2022 Eze Castle Software, LLC. Page 11 of 146



Multi-Factor Authentication is an enhanced login method requiring both your password and another 
piece of information that only you have access to. In the case of Eze EMS, this additional information is a 
One Time Password (OTP) that is sent to your registered email address or retrieved from an 
authenticator app (e.g., Microsoft Authenticator or Google Authenticator). By using both your password 
and a unique OTP, it is more difficult for another party to impersonate you and access your data.

Note: Contact your SS&C Eze client service representative to enable MFA.

Setting Up MFA in Eze EMS

If you are logging into Eze EMS or RealTick Extra with MFA for the first time, you are redirected to the 
2FA Configuration Page immediately after your login information is successfully validated. Customize 
your OTP delivery preference and information to finish setting up MFA on your system.

To enable email as your preferred mode of delivery for MFA in Eze EMS:

 1. In the Eze EMS login window, enter your Username, Domain, Password, and Locale and click OK.

 2. You are redirected to the 2FA Configuration Page, shown below. Select Email from the Delivery 
Preference drop-down list.

 3. In the Email field, enter the email address you would like the OTP sent to.

 4. Click Save. You are returned to the Eze EMS login window.

 5. Re-enter your Username, Domain, Password, and Locale and click OK. A unique OTP is sent to the 
email address you provided each time you login to Eze EMS. Use this OTP to login to Eze EMS with 
MFA.

Note: Email is the default Delivery Preference.

To enable an authenticator app as your preferred mode of delivery for MFA in Eze EMS:

 1. In the Eze EMS login window, enter your Username, Domain, Password, and Locale and click OK.

 2. When the 2FA Configuration Page appears, select Authenticator App from the Delivery 
Preference drop-down list. A QR code is displayed on the screen that is unique to each user, as 
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shown below.

 3. Open the authenticator app on your mobile device and follow the instructions to scan the QR 
code and add Eze EMS to the app.

 4. Click Save. You are returned to the Eze EMS login window.

 5. Re-enter your Username, Domain, Password, and Locale and click OK. A unique OTP will be sent 
to the  authenticator app each time you login to Eze EMS. Use this OTP to login to Eze EMS with 
MFA.

Setting Up MFA in RealTick Extra

To enable email as your preferred mode of delivery for MFA in RealTick Extra:

 1. In the RealTick Extra login window, shown below, enter your Username, Domain, and Password 
and click Sign In.

Eze EMS Quick Start Guide | © 2022 Eze Castle Software, LLC. Page 13 of 146



 2. When the 2FA Configuration Page appears, select Email from the Delivery Preference drop-down 
list.

 3. In the Email field, enter the email address you would like the OTP sent to.

 4. Click Save. You are returned to the RealTick Extra login window.

 5. Re-enter enter your Username, Domain, and Password and click Sign In. You will now receive a 
unique OTP via the email address you provided each time you login to RealTick Extra. Use this 
OTP to login to RealTick Extra with MFA.

Note: Email is the default Delivery Preference.

To enable an authenticator app as your preferred mode of delivery for MFA in RealTick Extra:

 1. In the RealTick Extra login window, shown below, enter your Username, Domain, and Password 
and click Sign In.

 2. When the 2FA Configuration Page appears, select Authenticator App from the Delivery 
Preference drop-down list. A QR code is displayed on the screen that is unique to each user.

 3. Open the authenticator app on your mobile device and follow the instructions to scan the QR 
code and add RealTick Extra to the app.

 4. Click Save. You are returned to the RealTick Extra login window.

 5. Re-enter your Username, Domain, and Password and click Sign In. You will now receive a unique 
OTP via the authenticator app each time you login to RealTick Extra. Use this OTP to login to 
RealTick Extra with MFA.

Using Multi-Factor Authentication in Eze EMS

To login to Eze EMS using MFA:

 1. In the Eze EMS login window, enter your Username, Domain, Password, and Locale and click OK. 

 2. A unique One Time Password (OTP) is sent to you via your selected delivery preference (i.e., email 
or authenticator app). Check your configured authentication method to retrieve the code. An 
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example of an email with an OTP is shown below.

 3. Return to Eze EMS and enter the OTP in the Security Code field of the Step Two of Verification 
window and click OK. An example of a Step Two of Verification window for email delivery is 
shown below.

If Email is selected as your delivery preference and you do not receive an OTP, you have the option to 
resend a new code after one minute has passed.

To send a new OTP, click Resend Code on the Step Two of Verification window.

Note: Contact your SS&C Eze client service representative if you still do not receive a security 
code.

In addition, if you enter an incorrect OTP on the Step Two of Verification window, you are redirected to 
the Eze EMS login window. Re-enter your login information to generate a new OTP.

Using Multi-Factor Authentication in RealTick Extra

To login to RealTick Extra using MFA:
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 1. In the RealTick Extra login window, enter your Username, Domain, and Password and click Sign In.

 2. A unique One Time Password (OTP) is sent to you via your selected delivery preference (i.e., email 
or authenticator app). Check your configured authentication method to retrieve the code.

 3. Return to RealTick Extra and enter the provided OTP in the Security Code field of the Step Two of 
Verification window and click Submit. An example of a Step Two of Verification window for email 
delivery is shown below.

If Email is configured as your delivery preference and you do not receive an OTP, you have the option to 
resend a new code after one minute has passed.

To send a new OTP, click Generate New Code on the Step Two of Verification window.

Note: Contact your SS&C Eze client service representative if you still do not receive a security 
code.

In addition, if you enter an incorrect OTP on the Step Two of Verification window, you are redirected to 
the RealTick Extra login window. Re-enter your login information to generate a new OTP.

2FA Configuration Page

The 2FA Configuration Page is available in both Eze EMS and RealTick Extra. You can use the 2FA 
Configuration Page to customize or verify your OTP delivery preference and information for Multi-Factor 
Authentication.

Note: The delivery preference and information you provide on the 2FA Configuration Page is 
applied to MFA in both Eze EMS and RealTick Extra.

Accessing the 2FA Configuration Page in Eze EMS and RealTick Extra

You can access the 2FA Configuration Page to change your delivery preferences at any time.
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To access the 2FA Configuration Page in Eze EMS, do one of the following:

 l Click on the Tools menu and select Change 2nd Factor Authentication Settings..., as shown below. 

 

 l Right-click on the Eze EMS green lock ( ) on your computer’s task bar and select Change 2FA 
Settings…, as shown below.

To access the 2FA Configuration Page in RealTick Extra, click on Configure 2FA Settings on the Home 
screen, as shown below.
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What Is Installed With Eze EMS
The Eze EMS install directory contains .dll files, .exe files, and other files necessary for your application to 
run. It includes the sub-directories described below:

Sub-Directory Description

Analysis
The Analysis directory contains preconfigured studies that come out of the box 
with Eze EMS as well as studies that you configure and save.

Data
The Data directory contains your activities within the application for a particular 
day.

Favorites
The Favorites directory contains your saved favorites and preconfigured win-
dows.

Help The Help directory contains the context sensitive Help system for Eze EMS.

Mail The Mail directory contains the files for TAL Mail.

Pages
The Pages directory contains all your save Eze EMS pages, including their layouts 
and preferred window arrangements.

Parm
The Parm directory contains all the symbol lists as well as the Market Minder 
and MultiQUote layouts.

Sounds
The Sounds directory contains all the sound files used for Eze EMS Alarms and 
Alerts.

Temp
The Temp directory contains files such as MultiQuote and Market Minder lay-
outs that are encapsulated with a page or favorite, but are not saved in the Parm 
directory.

Trading The Trading directory contains the files for order actions in Eze EMS.
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Accounts
Before you can place orders or view data, you must select an account. Eze EMS supports the following 
types of user accounts:

 l Neutral – An account  not associated with any routes.

 l Trading – An account  associated with specific routes. 

 l Multi-broker – An account  associated with the selected firm or broker.

 l Virtual –  A client-side pseudo-account representing a collection of real accounts. Refer to the Vir-
tual accounts section for more information.

The following windows require you to select an account while opening:

 l Charts

 l Market Minder

 l MarketMakers

 l MultiQuote

 l Order Entry

 l Slicer

 l TabView

 l TurboOptions®

Selecting an Account
You can select an account in Eze EMS from a drop-down list in some windows, as shown below. However, 
most accounts are selected from the menu option.
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To select an account from the menu:

 1. Click on the menu for the window you are using (i.e. MarketMaker, MultiQuote, Charts, etc.) and 
click Select Account..., as shown below. 

 2. Select an account from the list in the Available Accounts field and then click OK. 
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Selecting Default Neutral Accounts
You can set a default neutral account for the Staged Pairs Order form. The ability to set a default neutral 
account increases your efficiency when creating an order since it eliminates the process of selecting a 
neutral account every time you stage a pair order.

To set the default neutral account from the Order Entry Properties window:

 1. Click on the Trading menu, select Order Entry Properties..., and then select the Pairs and Spreads 
tab.

 2. Select NEUTRAL from the Default Neutral Account drop-down list and then click OK.

The selected neutral account appears as default in the Staged Pair Order and Broker Pair Algo forms.
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Note: You can override the default neutral account in the Staged Pair Order and Broker Pair 
Algo forms.

Selecting Multi-Broker Accounts
As a multi-broker trader, you can create a default firm/account association. 

Note: Multi-broker features, such as the Firm/Broker list on the Select Account window, 
require specific permission. Contact your SS&C Eze client service representative to set up 
multi-broker features.

To create default firm-account association:

 1. Select a firm or broker from the Firm/Broker drop-down list in the Select Account window. 

 2. All accounts associated with the selected firm or broker appear in the Available Accounts field.

 3. Select the desired account from the Available Accounts field and then click OK, as shown below.

Virtual Accounts
You can trade different currencies, routes, and securities for different accounts, all in one account by 
creating a virtual account. If you trade using a virtual account, Eze EMS automatically aggregates these 
trades into appropriate accounts.

Virtual accounts offer the following benefits:

 l A consolidated order blotter view

 l Aggregated positions

 l Aggregated account balances
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Virtual accounts can contain an explicit list of accounts, or they can be configured to include wildcards, 
which are interpreted at start-up.  Wildcards are useful if new accounts are added periodically 
(representing traders or funds) and you want to avoid re-configuring the virtual account each time. 

For example, if a virtual account includes TAL;HARTFORD;DEREK;*, then all accounts underneath DEREK 
in the BBCD hierarchy would be included.

Note: Virtual Accounts are implemented only on the client; therefore, Eze EMS cannot send 
an order to the trade server using a virtual account.

Configuring a Virtual Account

To configure a virtual account:

 1. Click Virtual Account... on the Select Account window.

 2. When the Virtual Account Dialog Manager window appears, click New, as shown below.

 3. In the Virtual Account Properties window, shown below, enter a name for your virtual account in 
the Account Name field.
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 4. Select the accounts in the Available Accounts field that you would like to add to your virtual 
account.

 5. Use the less than (>) or greater than  (<) arrows to add or remove an account, respectively.

 6. Select desired currency from the Account Currency drop-down list.

Note: The account currency is only for assessment purposes. You select an account currency 
to easily monitor the account in a Position Blotter. For example, if you have an account that is 
trading in Japanese Yen and Mexican Peso, but you want the account's positions to be 
displayed in a different currency (e.g., U.S. Dollar) in the Position Blotter, you can set the 
account currency to easily assess the accounts.

 7. Click OK.

 8. Click OK on the Virtual Account Dialog Manager window.

The virtual account is added to the list of available accounts in the Select Account window.

Setting up a Default Virtual Account

When trading in virtual accounts, Eze EMS can use account defaults specified in the Order Entry 
Properties window. For more information on how to set a default account, see the Selecting default 
neutral accounts section.

To set up a default virtual account:

 1. From the Select Account window, click the Virtual Account... button.

 2. Select an account in the Virtual Account Dialog Manager window.
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 3. Select Use Default Account specified in Order Entry Properties, as shown below, and click OK.
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EMS Workspace
The Eze EMS user interface provides a wide variety of features that are fully customizable. Main areas of 
the user interface are described below. 

Default Layout Screen

The Eze EMS user interface has the following components:

 l Page — The main area in which you can add customized or pre-configured window layouts using 
the Page menu.

 l Window — A window displays information about multiple view available in EMS such as charts, 
watch lists, blotters, and order entry forms. You can organize these views within windows into one 
or more tabs. You can perform actions such as:

 Dock the least used window(s).

 Add new windows to an existing page via the Design menu.

 Link windows, to create a link between two windows.

 Clone windows, to clone an existing window.

 l Menu — The primary Eze EMS menus include Page, Design (Windows), Favorites, Trading, Pairs, 
Tools, Window, and Help. Additional menus appear depending on the windows that are added to 
the page.

 l Toolbar — The toolbar appears at the top of the page; it displays a list of window designs. You can 
also move toolbars and edit the functionality that is available via the toolbar. Additional toolbars 
are automatically added to the page for some windows.

 l Docked Window — You can dock the window(s) by moving them outside the Eze EMS mainframe.
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Customize Workspace
In Eze EMS, you can customize your workspace, including the ability to set the color and font for 
windows, or adjust the size of the windows. You can also set defaults, such as a open a desired page on 
launch, or hide a window title. 

You can set defaults using the Configuration window (Tools > Configuration...). The settings are applied 
on the Eze EMS framework, or on all Eze EMS windows.

Setting Page Defaults
To set default page settings:

 1. Click on the Tools menu, select Configuration..., and then select the Page tab, as shown below.

 2. Configure the desired settings, and then click OK. The following settings  can be configured for a 
page:

 l Startup options

 l Save page on exit

 l Embed layout files in pages and favorites when possible

 l Stretch windows when frame window is resized

 l Minimize detached windows when frame window is minimized

 l Use grid when resizing windows

 l Set page grid size
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Adjusting Common Workspaces
You can select how the windows appear on the page. Navigate to the Windows menu and select one of 
the options below to change the appearance:

 l Tile

 l Tile Horizontally

 l Cascade

Additionally, to manually adjust the size of the window, hover over the edge of the window to get the 
double-headed arrow. Click and drag in the desired direction.

Changing Window Colors
To change the window color:

 1. Click on the Tools menu, select Configuration..., and then select the Colors/Fonts tab, as shown 
below.

 2. Select Turn on Theme and choose the desired theme from the drop-down list.

 3. You can select the desired color from the color palette by clicking the square next to Background, 
Gradient, Text, or Selected Rows.

 4. You can make the grids and borders visible by selecting Grid & Border and click the cell to select 
the desired color from the color palette.

 5. You can change the color of Up and Down Ticks by clicking the square next to Up Tick or Down 
Tick and selecting the desired color from the color palette.
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 6. Click OK to save the changes for the theme. If you want to create a new theme, enter the name in 
the Save As field, and then click OK. The saved theme is added in the Turn on Theme drop-down 
list.

Hiding a Window Title
To hide the window title:

 1. Click on the Tools menu, select Configuration..., and then select the Window Captions tab, as 
shown below.

 2. To change the window title display, select one of the following options from the Window Caption 
drop-down list:

 l Hide

 l Show

 l Only On Mouse Hover

 3. To modify the window frame settings, select one of the following options from the Window 
Frame drop-down list:

 l Thick

 l Thin

Note: The Thin option is not available if Show is selected as the option for Window Caption.

 4. Click OK. 

Adding and Removing Columns
You can add or remove columns in a window while using Eze EMS.

Eze EMS Quick Start Guide | © 2022 Eze Castle Software, LLC. Page 30 of 146



Adding Columns

To add a column:

 1. Right-click the column header and select Add Column..., as shown below.

 2. Select the desired field or search for it in the Search field, as shown below. You can also select 
columns using the Category tab.
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 3. Click OK. 

Removing Columns

To remove/hide a column:

 1. Right-click the column header you want to remove and select Hide Column, as shown below.

 2. Alternatively, you can right-click the column header and select Selected Columns, as shown 
below. Click the column you want to remove from the window.
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Dragging and Dropping Columns
To arrange the columns in a window, you can click the column header and move it to the desired 
location.

Configuring Column Layouts
To configure column layout:

 1. Right-click the window, select Column Layout Choices, and then click Configure Column Layout..., 
as shown below. Alternatively, you can click F5 on your keyboard.
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 2. The Column Configuration window appears, as shown below.

 3. Click Add Field..., the Select Fields window appears where you can search and add the desired 
fields to the window.            

 4. Click Add Analysis..., the Select Custom Field : Study window appears where you can select stud-
ies and conditions to be added to the window.             

 5. Select a column and click:
 l Edit to edit a selected field.

 l Delete to remove a selected field.

 l Use the Move to Top, Move Up, Move Down, Move to Bottom buttons to move a selected 
field.            

 6. Configure the desired settings in Other Layout Options to  change the appearance of the window.             

 7. Click OK.             

 8. Optionally, to save your current column layout changes, right-click the window, select Column Lay-
out Choices, and then click Save Column Layout. To save the changes as a separate column lay-
out, click Save Column Layout As..., provide a name for the layout with .bvw extension, and then 
click Save. You can use the saved file to directly apply it on a window layout. Refer to the Specify 
column layout section for more information.

Specifying Column Layout
You can select a column layout for the window as per your requirement.
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To load an existing column layout:

 1. Right-click the window, select Column Layout Choices, and then click Load Column Layout..., as 
shown below. 

 2. When the Open Layout window appears, select the desired layout.

 3. Click Open.

Docking Windows
You can dock the windows in a particular location on the page.

To dock a window:

 1. Right-click the window and select Detach Window.

 2. Click the window header and start moving it in the direction you want to dock. The direction 
arrows appear in the middle of the screen, as shown below. Hover-over the arrow that represents 
the direction in which you want to dock the window, and then release the mouse. Ensure that 
you  see your desired docking area highlighted before releasing the mouse cursor.
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Basic Features
This section provides basic information on Eze EMS features, to help you get familiar with using the 
system.

Working with a Page
A page is a collection of related windows that are opened and closed at some time while using the 
application. If you open a window, it is added to the current page and when you close a window, it is 
deleted. You can save changes made to the window(s) on a current page before you close it.

Setting a Start Page

In Eze EMS, you can customize the windows and page settings.

To set up a start page in Eze EMS:

 1. Click on the  Tools menu and select Configuration.... The Configuration window appears.

 2. Select the Page tab, as shown below.

 3. Select the desired option from the Startup Options drop-down list. You can select one of the fol-
lowing options:

 l Do not load a Page – No page opens when you launch the Eze EMS application.  For more 
information on how to open a page, see Opening an existing page.

 l Load Most Recent Page – Opens the last page of the previous session.

 l Load First Page – Opens the first page saved in your local repository (e.g., 
C:\EzeEMS\PAGES).
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 l Select Page to Load – Provides option to select and open a pre-saved page  when you 
launch the Eze EMS application.

 4. Click OK.

Creating a New Page

Eze EMS provides the ability to create a new page with the windows that you frequently need to access.

To create a new page in Eze EMS:

 1. Click on the  Page and select New, as shown below, or press Shift + F2 on the keyboard.

 2. Eze EMS appears with a blank screen. Open the windows that you want to include on the page 
from the Design menu.

 3. Click the Page menu and select Save As. The Save Page As window appears.

 4. Enter a name for the page in the File name field and click Save.

Opening an Existing Page

When you open the Eze EMS application, you can choose to open an existing page; either a default page 
or a saved page from the default installation location (e.g., C:\EzeEMS\PAGES). There are a few default 
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pages that are available with the installation package. You can also customize a page and save it as a new 
page. For more information on how to create a new page, see Creating a new page.

To open an existing page:

 1. Click on the Page menu and select Open or press Alt + O on the keyboard. The Open Page... win-
dow appears, as shown below.

 2. Select the page to open, and then click Open. Alternatively, double-click the desired page.

Setting Favorites
You can save your most-used windows as favorites for quick access. Additionally, if you want to set a 
default parameter for a single page, you can set up a favorite to quickly access the page. 

Add a Favorite

To create a favorite:

 1. Open your desired window and select Add to Favorites from the Favorites menu. Or, right-click 
the window, click Favorites and then select Add to Favorites. The Save Favorite window appears, 
as shown below.
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 2. Enter the name of the favorite in the Please select a name for this favorite field.

 3. You can select any combination of the following options (i.e., one, two, or all three options):
 l  Save Position – Opens the window in the same place on any page every time you open it.

 l  Setup After Opening – Opens the window’s set up window  every time you open your favor-
ite.

 l Use As Default – Creates this window every time you use the toolbar button corresponding 
to the window type.

 4. Click OK. The window is saved as a favorite in the Favorites tab.

Editing Favorites

To edit a favorite page:

 1. Click on the Favorites menu and select Edit Favotires. The Edit Favorites window appears, as 
shown below.

 2. Select the window from the Window Type drop-down list.
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 3. Click the favorite you want to change in the Favorites box.

 4. Click Edit. The Save Favorite window appears, as shown below.

 5. Enter a name for the favorite in the Please select a name for this favorite field.

 6. You can select any combination of the following options (i.e., one, two, or all three options):
 l  Save Position – Opens the window in the same place on any page every time you open it.

 l  Setup After Opening – Opens the window’s set up window  every time you open your favor-
ite.

 l Use as Default – Creates this window every time you use the toolbar button corresponding 
to the window type.

 7. Click OK. The changes are saved.

 8. Select Close to exit.

Organizing Favorites

To organize your favorites:

 1. Click on the Favorites menu and select Edit Favorites.             

 2. Select a favorite from the Favorites box and use the Move Up or Move Down buttons to arrange 
the order of your favorites, as shown below.                                      
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 3. Click Close.             

Deleting a Favorite

To delete favorite:

 1. Click on the Favorites menu and select Edit Favorites. 

 2. Select the window from the Window Type drop-down list.

 3. Select the favorite you want to delete in the Favorites box.

 4. Click Delete. The favorite is deleted.

 5. Select Close to exit.

Page and Favorite Loading Options
Eze EMS allows you to customize how your system opens pages with specific layouts and the files 
associated with them.

To customize page and favorite loading options:

 1. Go to Tools > Configuration... and select the Page tab.

 2. Select the Embed layout files in pages and favorites when possible checkbox to allows pages and 
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favorites to be more easily distributed. 

 3. Select Use file in the install directory (classic mode) to use the layout that is installed with Eze 
EMS.

 4. Select Use file embedded in Page/Favorite to display the layout designated as the favorite.

 5. Select Use newer version to have Eze EMS compare and display the newest layout of the two 
above options.

 6. Click Embedded File Options.... The Page/Favorite Loading Options window appears, as shown 
below. This window allows you to specify the default behavior of Eze EMS when the embdedded 
file is different from the file in the install directory.

 7. The Save embedded file to the install directory (will overwrite existing file)  checkbox is only 
available when Use file embedded in Page/Favorite or Use newer version is selected. When this 
checkbox is selected, Eze EMS overwrites the existing file with the selected one. 

For example, when this checkbox is selected and you choose Use file embedded in Page/Favorite, 
Eze EMS will replace the layout currently on your system with the layout in the favorite. 

 8. Select the Always prompt when loading a page or favorite checkbox to receive a prompt to 
modify these setting each time a page loads.

 9. When you have made your selections, click OK.

Linking Windows
You can link a MultiQuote or Market Minder window to another window, such as Chart or News. When 
you update a symbol in the first window, the related data is displayed in the linked window.

To link windows:

 1. Right-click and select Links on the MultiQuote or Market Minder menu. The Select Window to 
Link window appears.
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 2. Select the window(s) you would like to link. To choose multiple windows with the mouse, hold 
down the CTRL key on the keyboard.

 3. Click OK. The windows are linked.

Configuring Performance Settings
To configure performance settings:

 1. Click on the Trading menu, select Order Entry Properties..., and then select the Performance 
Options tab, shown below.
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 2. Complete the desired settings and then click OK.

Setting Currency Defaults
To set currency defaults:
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 1. Click on the Tools menu, select Configuration..., and then select the Currency tab, shown below.

 2. Click Options.... The Set Currency Options window appears, as shown below. 

 3. Complete the desired settings and click OK.

Displaying Fractional Prices

Eze EMS displays trades in decimal units with a decimal point (e.g., 463.55). However, you can change 
the way Eze EMS displays the price data. You can also determine whether or not prices are displayed in 
the least common denominator.
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To change the way price data is displayed in Eze EMS:

 1. Click on the Toolsmenu, select Configuration..., and then select the General tab.

 2. Select the Display Fractional Prices as LCD box to reduce fractional prices to the least common 
denominator (e.g., 4/16 becomes 1/4), as shown below.

 3. Click OK.

Setting Currency Options

Eze EMS supports the use of numerous foreign currencies. Currencies can be specified for spreads in the 
Synthetic Symbol Manager. Currency conversion is supported in the MarketMinder (via Configure 
Column Layout), MultiQuote (via Setup), Trade Manager (via Configure Columns), and in the 
MarketMaker.

To modify currency settings:

 1. Click on the Tools menu, select Configuration..., and then select the Currency tab.

 2. The Currency settings section displays the home currency selected for Eze EMS. 

 3. Click the Options...button. The Set Currency Options window appears.

 4. Highlight the desired currency to select. The following three columns appear in the Currency Sym-
bol section:

 l Root – Three-letter code to indicate currency and country of origin.

 l Symbol – Symbol displayed with price shown in selected currency.

 l Description – Description of currency.

 5. Select Show all currencies to display all available currencies.
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 6. Enter a new symbol in the Symbol field to add to a currency without a symbol, or to replace the 
symbol for an existing currency.

 7. Click Set Symbol to set the symbol for the highlighted currency.

 8. Click Set as home currency to set the selected currency as the home currency (global setting 
across all supported modules in Eze EMS).

 9. Select the preferred source from the Cross rate source drop-down list. Exchange rates are cal-
culated in real time.

 10. Select Use static rates if rates from the source is not available to revert to static rates if the pre-
ferred source is unavailable to provide data. This box is not available when Use static rates is selec-
ted under Cross rate source field.

 11. Click OK.

Setting Case Sensitivity for Keyboard Entries
To enter symbols in upper case regardless of your keyboard setting and hide the page name for the title 
bar.

To modify case sensitivity settings:

 1. Go to Tools > Configuration and then select the General tab.

 2. Check the Upper Case Symbols box if you want all symbols to be in upper case, regardless of how 
you type them.

 3. Click OK.

Configuring Hot Keys
You can assign keyboard combinations to press to quickly buy or sell stocks. You can create a function 
key, Ctrl +, or Alt + combination for quick buys and sells. 

To configure hot keys:

 1. Click on the Trading menu, select Order Entry Properties..., and then select Order Actions 
Manager, as shown below.  
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 2. Click New to create a new hot key and select whether you would like to create a new Order 
Action, List Trading Action, Staged Pair Action, or Macro. 
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 3. In the New/Edit Action window, shown below, select the desired options and click OK. 

 4. When the New Action Filename dialog box appears, enter a name for the new action and click OK, 
as shown below. 
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 5. Select an option from the Order Actions list and click:
 l Edit – to edit the hot key.

 l Clone – to clone the hot key.

 l Delete – to delete the hot key.

 6. Select an option in Order Actions and press keyboard combination (e.g., Ctrl + N) while placing 
the cursor in the Hotkey field to assign a hot key to the selected order action.

 7. Click OK.

Setting External Scripting Options
Almost any action that can be performed via a menu or a dialog box in Eze EMS can be made scriptable. 

To set your scripting options:

 1. Click on the Tools menu, select Configuration..., and then select the Scripting tab, as shown 
below.

 2. On the Scripting tab, make the following selections:

 l Allow Scripting — When selected, scripting is enabled on your Eze EMS.

 l Allow Order Entry Scripting — When selected, order scripting is enabled on your Eze EMS.

 l Allow Unattended Script Orders — When selected, orders placed via a scripting interface 
do not pop up any dialogs while an order is placed. All warning are ignored if Eze EMS is 
able to proceed. If there is an error, the message box does not appear, but the message is 
logged.
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 l Require Password for Order Scripting — When selected, a password is required to use 
order scripting in Eze EMS.

 3. When you are done customizing your scripting settings, click OK. 
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Permissions
Certain features within Eze EMS are only available for specific users. To gain access to these features, 
your system needs to be configured with the appropriate permissions. 

Note: If you have any questions regarding your Eze EMS permissions, contact your SS&C Eze 
client service representative.

Show Application Permissions
To view the Eze EMS application permissions currently configured on your system, click on the Help 
menu and select Show Applications Perms, as shown below.

A web browser window opens within Eze EMS displaying all your current application permissions, as 
shown below.
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Show Trading Permissions
To view the trading permissions currently configure on your system, click on the Help menu and select 
Show Trading Perms, as shown below.
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A web browser window opens within Eze EMS displaying all your current trading permissions, as shown 
below.
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Printing
Eze EMS allows you to print a page, a window on a page, or a screenshot of the entire computer screen, 
including all of Eze EMS and other open applications.

In addition, many windows have their own printing logic that allows you to print data that is not currently 
visible on the screen.

Print All Open Eze EMS Windows
You can print all open Eze EMS windows in one of the following ways:

 l Click on the Page menu and select Print All, as shown below.

 l Press Ctrl + Shift + P on the keyboard.

Print a Specific Eze EMS Window
You can print a specific Eze EMS window in one of the following ways:
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 l Click on the window you would like to print > click on the Page menu > Print..., as shown below.

 l Click on the window you would like to print and press Ctrl + P on the keyboard.

Use the Eze EMS Print Feature
The Eze EMS Print Feature allows you to specify what you would like to print and how you would like it to 
be scaled.

To use the print feature:

 1. Open the Print Screen Configuration window by clicking on the Page menu and selecting Print 
Screen....

 2. In the Window to Print pane, choose from the following screen regions:

 l Windows Desktop — Prints your entire computer screen.

 l Application Only — Prints the entire Eze EMS window, including menus, toolbars, and the 
status bar.

 l Application Only (no cap) — Prints only the windows on the current page, without menus, 
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toolbars, or status bars.

 l Active Window — Prints the active window only.

 3. In the Printer Scaling pane, choose from the following options:

 l Best Fit — Maintains the proportions of the window that you are printing.

 l Snap to Printer — Fills the entire page area, changing the proportions of the window and its 
contents.

 4. To select a printer, click Printer....

 5. If you want to save the screenshot as a bitmap file, check the Output to File checkbox and enter a 
file name in the File field. Click File... to select a location to save the screenshot.

 6. Click OK to send the screenshot to the printer or save the file on your computer.
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Monitoring Market Performance
Eze EMS offers a variety of ways to monitor market performance before and throughout the trading day. 
This section describes the components and features that are available to you and how you can integrate 
them into your system.

Watch List
The Watch List window allows you to monitor a symbol’s pricing and data. You can integrate market data 
into your Eze EMS by:

 l Subscribing through Eze EMS

 l Retrieving data through the Bloomberg API

Creating a Watch List
To create a watch list:

 1. Click Market Minder on the Design menu. The Minder Setup window appears.
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 2. Select WatchList from the Minder Type drop-down list, as shown below.             

 3. In the Symbols tab, enter the symbol you want to watch in the Selected Symbols field and click 
Add.             

Note: You can only add one symbol at a time.

 4. Select the Miscellaneous tab and enter a name for your new watch list in the Window Title field, 
and then click OK, as shown below.
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 5. If the Select Account window appears, select the account you would like to use and click OK. 

Tips

Changing Display Options

To change the display of the watch list:

 1. Right-click your Watch List window and select Display Options... or click the WatchList Minder 
menu and select Display Options.... The Display Options window appears, as shown below.
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 2. Customize the settings as desired and click OK.

Configuring Columns

To configure columns:

 1. You can open the Column Configuration window by using any of the following options:
 l Right-click your Watch List window and select Column Layout Choices > Configure Column 

Layout....

 l Select WatchList Minder > Column Layout Choices > Configure Column Layout... from the 
top ribbon.

 l Press F5.

 2. Select or deselect the checkboxes to add or remove columns from your Watch List window, as 
shown below.
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 3. To add an additional column, click Add Field…. The Select Fields window appears, as shown 
below.

Eze EMS Quick Start Guide | © 2022 Eze Castle Software, LLC. Page 62 of 146



 4. Select the fields you would like to add and click OK.

 5. Change the order of your columns by selecting the field you would like to move, and use the 
Move to Top, Move Up, Move Down, and Move to Bottom buttons to change its position, as 
shown below.

 6. Click OK.
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Charts
The Charts component allows you to create graphs in your Eze EMS to easily view price, volume, and 
percent change information for symbols. Charts help you track upward and downward trends in the 
market in a visual format, allowing you to easily compare a stock's historical value over time.

Depending on the data criteria, your chart will present data in either historical and/or real time. The data 
criteria used to create charts includes time intervals (i.e., Intraday, Daily, Weekly, Monthly, Seasonal, and 
Time and Sales) and price criteria (i.e., Bids Only, Asks Only, and Bid & Asks).

In all charts, the time is displayed on the horizontal axis (x-axis) and the price is displayed on the vertical 
axis (y-axis), as shown below.

The Chart window provides real-time tracking for:

 l Trades

 l Intraday Bars

 l Daily/Weekly/Monthly Bars

 l Tick Bars/Volume Bars

Creating a Chart
To create a chart:

 1. Click Chart on the Design  menu. The Chart Setup window appears.

 2. Enter one or more symbols into the Symbols field and click Add, as shown below.
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 3. Make the other necessary selections in the Chart Selection, Date Selection, and Appearance 
panes.

 4. Click OK  to create the chart.
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Tables
The Table window allows you to display data numerically, in rows and columns, instead of in a graph, like 
with Charts. You can use the Table window to display data for a specific time period, such as intraday, 
daily, weekly, or monthly. In addition, volume, open interest, and exchange information can also be 
displayed, along with technical studies.

For example, shown below is a Table window configured to display intraday data.

Creating a Table
To create a table:

 1. Click Table on the Design menu. The Table Setup window appears.
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 2. Type the symbol in the Symbols field and click the Add, as shown below.

Note: Only one symbol data is displayed at a time.

 3. Make the other necessary selections in the Chart Selection, Date Selection, and Appearance 
panes.

 4. Click OK to create the table.
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News Window
The News window allows you to follow market movements as well as a wide variety of press releases and 
announcements that may affect prices by including news headlines and stories in your Eze EMS.

The News window has the following components:

 l Toolbar — Filters stories by searching for keywords, categories, symbols, sources, and pages.

 l Headline Panel — The upper box. Displays incoming headlines in real time.

 l Story Panel — The lower box. When a headline is highlighted in the Headline Panel, the cor-
responding story appears in the Story Panel.

Opening and Configuring the News Window
To create a news window:

 1. Click News on the Design menu. The Quick Search Criteria window appears along with your News 
window, as shown below.
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 2. Configure the settings and click OK.

Note: You can view the Quick Search Criteria window by:

 l Clicking the Advanced Search… button at the top of your News window.

 l Choosing Search Criteria… from the News window right-click menu.

 l Pressing F4.

To configure the news window:

 1. Open the Configure window by:
 l Right-click your News window and select Configure….

 l On the top ribbon, click the News menu and select Configure....

 l Press F6.
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 2. In the Configure window, as shown below, customize your settings and click OK.
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Web Browser
The Web Browser window allows you to view websites on the internet within your Eze EMS. You can use 
the Web Browser to view stock tips, news stories, and more, without leaving the Eze EMS.

Opening the Web Browser
To open the web browser:

 1. Click Web Browser on the Design menu. The Browser Setup window appears.

 2. Type the web address you want to open in the Current URL field, as shown below.

 3. Click OK. Your Web Browser window loads your selected URL.
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Corporate Actions
The Corporate Actions window allows you to track stock activity, such as dividends, stock splits, and 
initial public offerings. The Corporate Actions window displays the symbol, the date of the action, and the 
description of the action.

Creating a Corporate Action
To create a corporate action:

 1. Click Corporate Actions on the Design menu. The Corporate Actions Setup window appears, as 
shown below.

 2. Type a symbol in the Symbol field.

 3. Select an action from Type of Action drop-down list.

 4. In the Select Dates pane, select the appropriate date criteria.

 5. If you select From and to, type the time period you would like the system to search in the From 
and to fields. Ensure the date format is MM/DD/YYYY.

 6. Click Search.
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Alarms and Alerts
Eze EMS offers the Alarms and Alerts components to help you stay on top of market activity throughout 
the trading day.

Alarms
Eze EMS’ configurable Alarms allows you to be notified when a specific security's last price, net change, 
bid, offer, high, low, volume, new high, or new low falls below, falls to, or rises above a value you specify.

Creating an Alarm

To create an alarm:

 1. Click RealTick Alarms on the Design menu. The Alarm Setup window appears.

 2. In the Symbol Selection tab, select one of the following:

 l Click Symbol Criteria to select symbols to be monitored.

 l Click Symbol File to load a file.

 l Click Server Scan to select a symbol from a server.

 3. Enter additional information in the Filter Parameters, General Settings, and Sounds tabs.

 4. Click OK.

Alerts
Order Alerts in Eze EMS allow you to configure custom alerts for orders based on market and order 
parameters. Eze EMS offers three types of Order Alerts:
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 l Standard Order Alerts

 l Staged Order Alerts

 l Advanced Order Alerts

Standard and Staged Order Alerts are defined per Account/Customer rule and are triggered by order 
events. Advanced Order Alerts are defined per user and check orders on a timer to see if certain 
conditions are met.

Creating and Managing Order Alerts

Order Alerts are configured in the Order Alerts tab of the Order Entry Properties (OEP) window (Trading 
> Order Entry Properties > Order Alerts).

To create an order alert:

 1. In the Order Alerts tab of the Order Entry Properties window, click New. The Add New Rule win-
dow appears, as shown below.

 2. In the Select Account pane, select a specific account or click the Select ALL checkbox to select all 
accounts.

 3. In the Select Customer pane, select a specific customer or click the Select All checkbox.

 4. Click OK. Your new rule is automatically enabled and appears in the Account/Customer Rules 
pane.

Note: You can enable and disable rules by selecting or deselecting the checkbox next to the 
Account Name. The disabled rules retain their settings but are not active for triggering alerts.

 5. Select a rule in the Account/Customer Rules pane and configure the desired setting for the rule in 
the Alerts for Selected Rule pane.

 6. Click OK.
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Note: If you do not click OK on the Order Alerts tab, your rule will not be saved.

To clone a rule:

 1. In the Order Alerts tab of the Order Entry Properties window, click Clone. The Clone order alert 
settings from Account... window appears, as shown below.

 2. In the Select Account pane, select a specific account or click the Select All checkbox to select all 
accounts.

 3. In the Select Customer pane, select a specific customer or click the Select All checkbox.

 4. Click OK. Your cloned rule is automatically enabled and appears in the Account/Customer Rules 
pane. The cloned rule has the same Order Alert settings enabled as the rule used to create it.

 5. Click OK.

Note: If you do not click OK on the Order Alerts tab, your cloned rule will not be saved.

To apply a rule's order alert settings to multiple preexisting rules:

 1. Hold down the Ctrl key and select the rule for which you would like the settings to be applied.

 2. Continue holding down the Ctrl key and select the rule(s) whose setting you want to copy from 
the previously highlighted rule.

 3. Click Apply.

Creating and Managing Advanced Order Alerts

Advanced Order Alerts can be configured for each account, providing you with greater control of the 
alerts you receive throughout the trading day.

To configure your advanced order alerts:
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 1. In the Order Alerts tab of the Order Entry Properties window, click Configure Advanced Alerts…, 
as shown below.

 2. In the Advanced Order Alerts window, shown below, choose the type of alert from the Alerts 
drop-down list.
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 3. Click the three dots next to the Account(s) field. The Account Selection window appears, as 
shown below.

Use the Available Account Filters pane to filter the available accounts and find the account(s) you are 
looking for. You can add accounts from the Available Accountsfield to the Selected Accounts field using 

the arrow button ( ), and then click OK.

 4. Customize the settings as necessary and click OK.

In addition, you can enable or disable all Advanced Order Alerts per Account/Customer rule from the 
Order Alerts tab.

To enable or disable all advanced order alerts:

 1. In the Account/Customer Rules pane of the Order Alerts tab, select the rule you would like to 
modify.
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 2. In the Other pane, select or deselect the Enable All Advanced Order Alerts checkbox, as shown 
below.

Note: The desired Account/Customer rule must be enabled for the order alert settings to be 
triggered.

 3. Click Apply.
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Ticker
Tickers display real-time price and volume information directly in Eze EMS. You can configure the window 
to work off explicit lists of symbols or a symbol pattern (e.g., NYSE Stocks).

Eze EMS offers three different types of Tickers: Jet Tickers, Cascade Tickers, and Grid Tickers.

In a Jet Ticker, the quotes scroll horizontally, from right to left, with the newest quotes appearing on the 
right, as shown below.

In a Cascade Ticker, the quotes scroll vertically, as shown below. You can choose whether the newest 
quote appears at the top or bottom of the list.

In a Grid Ticker, the information is displayed in columns with the quotes scrolling vertically, as shown 
below. You can choose whether the newest quote appears at the top or bottom of the list.
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Creating a Ticker
To create a ticker:

 1. Click Ticker on the Design menu. The Setup Ticker window appears, as shown below.
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 2. Customize your display in the Display Options pane.

 3. In the Data Source pane, select the data source you would like your ticker to  pull data based on 
Symbol Criteria, a Symbol List, or a Symbol File.

 4. In the Trades and Quotes to Show pane, select the types of trades and quotes you want to view.

 5. Click OK.
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Time and Sales
The Time & Sales window displays all transactions for a symbol during a particular trading day, as shown 
below.

Creating a Time & Sales Report
To create a time and sales report:

 1. Click Time & Sales on the Design menu. The Setup Time and Sales window appears, as shown 
below.
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 2. In the Symbol field, type the symbol you would like to see a report for.

 3. In the Date field, type the date you would like to see.

 4. Click OK.
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Bracket Orders
Bracket Orders allow you to get out of a position with a strategy that maximizes profit and minimizes 
loss. A Bracket Order consists of an entry order and an exit strategy with both profit and loss orders. 
When the entry order is executed, the exit strategy is placed.

In a Bracket Order, the total profit volume must equal the loss volume, which equals the entry volume. 
Therefore, as a profit order is executed, an equal volume of loss is canceled. As a loss order is executed, 
an equal volume of profit is canceled.

No special perms are required to enter Bracket Orders. The entry order type can be MKT or LMT. Profit 
orders are LMT and loss orders are STP or Trailing STP.

Entering a Bracket Order 
To enter a bracket order:

 1. Open the Bracket Order Entry Form (Trading > Create Ticket Form > Bracket Ticket).

 2. Check the Always show this window when placing a bracket order checkbox, as shown below.

When this checkbox is selected, whenever Buy or Sell is pressed, a window will pop-up that allows for the 
entry of your exit legs.

 3. Type a symbol in the Symbol field and choose an account from the Account drop-down list.

 4. Configure your entry and exit orders in the Entry Order and Exit Order panes.
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Note: To save an exit strategy, enter a name for the strategy in the Strategy field and click 
Save. This exit strategy will now be saved for use in future Bracket Orders and can be selected 
from the Strategy drop-down list.

 5. Click Place Orders. If the Select Account window appears, select the account you would like to use 
and click OK. 

 6. The Confirm Bracket Order pop-up window appears. Verify the information and click Send Order.
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Order Cancel Order (OCO)
Order Cancel Orders (OCOs) link two orders together, so if one is filled, the other is automatically 
canceled. OCOs are typically placed on either side of the market to hedge on market movement and 
guarantee that the order is filled at an acceptable price, no matter which direction the market moves.

Creating an Order Cancel Order 
OCOs have a designated order form within Eze EMS that allows you to specify whether the orders are for 
a buy or sell in addition to all the typical order entry fields (e.g., Order Type and Destination).

Note: OCOs may be placed with the order legs on different routes, however, the symbols 
must be the same.

To create an OCO:

 1. On your Order Entry Form, click the arrow, as shown below, or right-click > Show Windows > 
Order Entry Screen, or press F7 to view the Order Entry Form.

 2. Select System Order Forms and then select OCO.             

 3. Enter your order information and click Place Orders.             
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QuoteBoard
QuoteBoard provides you with real-time quotes for equities, options, futures, and other securities in one 
dynamic window. It offers a different way of viewing standard Market Minder data. Instead of a 
spreadsheet style with one symbol per multiple column layout, the QuoteBoard displays data in a one 
symbol per tile layout, as shown below.

The QuoteBoard provides market information, including Open, High, Low, Last, Net Change and Total 
Daily Volume, allowing you to track the daily range of a stock or futures product. In addition, you can 
quickly place trades from the QuoteBoard by double-clicking on a tile to bring up the Enter Order 
window.

Adding and Configuring QuoteBoard
To add the QuoteBoard window:

 1. Click QuoteBoard on the Design menu. The QuoteBoard Setup window appears.             

 2. Type a symbol in the Selected Symbols field and click Add, as shown below.             
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 3. Click OK.

To add a symbol to your QuoteBoard:

 1. Right-click the QuoteBoard and select Setup.... The QuoteBoard Setup window appears. This is 
the same window that appears anytime you add a new QuoteBoard.

 2. In the Selected Symbols field, type the symbol you would like to add to the QuoteBoard and click 
Add, and then click OK.

Note: You can add symbols that use RIC, Bloomberg (BBG), and TAL symbology.

To configure tiles in your QuoteBoard:

 1. Right-click the tile you would like to configure and select Configure Tiles.... The Tile Setup window 
appears, as shown below.

Eze EMS Quick Start Guide | © 2022 Eze Castle Software, LLC. Page 88 of 146



 l To add a new field, click Add Field…. The Select Fields window opens, allowing you to 
search for fields and add them to the tile.

 l To change the label or field from which the value is obtained, click Edit…. Customize the set-
tings and click OK.

 l To rearrange the order in which fields appear on your tile, use the Move to Top, Move Up, 
Move Down, or Move to Bottom buttons.

 2. Make the following selections:
 l Show Candlestick — When this checkbox is selected, the candlestick appears on the tile. 

This allows you to see the open and last price relative to the day's high and low range of 
prices for the security on the tile.

 l Show Country Flag — When this checkbox is selected, the flag of the security's country 
appears on the tile.

 3. Click OK.

You can also configure the color scheme of QuoteBoard through the Colors/Fonts tab of the 
Configuration window (Tools > Configuration… > Colors/Fonts).
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TCA Benchmark Columns
Transaction Cost Analysis (TCA) benchmarks help you analyze the cost of your financial transactions, both 
pre-trade and post-trade. As events happen in the system, the timestamp is recorded, and the trading 
event is augmented with current market data corresponding to the timestamp.

Eze EMS offers the following TCA benchmarks:

Order Benchmark Value Benchmark for the profit and loss of an order.

Order Net P&L
Net profit or loss of an order vs. the benchmark. Can also be expressed 
in basis points (Order Net P&L BPS) or in cents per share (Order Net 
P&L CPS).

Order Realized P&L
The realized profit or loss of an order vs. the benchmark. Can also be 
expressed in basis points (Order Realized P&L BPS) or in cents per 
share (Order Realized P&L CPS).

Order Unrealized P&L
The unrealized profit or loss of an order vs. benchmark. Can also be 
expressed in basis points (Order Unrealized P&L BPS) or in cents per 
share (Order Unrealized P&L CPS).

Target 10-Day ADV Percent
The target quantity as a percentage of the 10-day average day volume.
 Can also be expressed as a 5-, 20-, 50-, or 200-day average day 
volume.

Participation Rate
Executed shares as a percent of the total market volume for the secur-
ity.

Duration VWAP
The volume weighted average price (VWAP) from the time of order 
submission to the present, or until the order is no longer live.

Last Market
Market of execution for last fill, or indication of where the order was 
routed.

Last Market (norm) Normalized Last Market identifier.

Order MKT VWAP Delta
The VWAP from the time of order submission to the present, or until 
the market closes.

Original VWAP Original VWAP when the ticket was submitted.

Original Volume Original volume when ticket was submitted.

Volume Delta The change in volume since the ticket was submitted.

Liquidity Indicator Last liquidity indicator.

Trade Momentum Percent in order price since arrival.
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Adding TCA Benchmark Columns
You can view TCA benchmarks within your Eze EMS by adding TCA columns to your blotter windows.

To add TCA benchmark columns to a blotter:

 1. Open the Column Configuration window by:             

 l Right-click your blotter window, select Column Layout Choices, and select Configure 
Column Layout….             

 l Select Column Layout Choices from your blotter menu and then select Configure Column 
Layout….             

 l Press F5.             

 2. In the Column Configuration window, shown below, select the TCA benchmarks you would like to 
include in your blotter.             
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 3. If you do not see the field you wish to include, click Add Field…. The Select Fields window appears, 
as shown below.

 4. Click the Category tab and select tca from the list or use the Search field to find available TCA 
benchmarks.

 5. Select the TCA benchmarks you would like to include in your blotter. To select multiple fields, 
hold the Ctrl key while making your selections.

 6. Click OK. Make sure the new TCA benchmarks are selected in the Column Configuration window 
and click OK.
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Managing Orders
There are various ways to manage your orders in Eze EMS. This section outlines the different ways to 
create and route orders, and describes the different components and features that assist these 
workflows.

Creating Orders
The two primary options for creating orders in Eze EMS are Order Entry Forms and Create Ticket Forms. 
Order Entry Forms can be embedded into any window in Eze EMS (e.g., MarketMaker or Market Minder) 
or used as a pop-up window. The Create Ticket Form is accessed through the Trading menu and opens a 
stand-alone order form that is not associated with any window or trade.

Order Entry Form
Eze EMS offers Single Leg Order Entry Forms, to create, change, and clone orders, as well as Spread 
Order Entry Forms (Multi-Leg) to create, change, and clone groups of orders that are related. In addition, 
you can use your system’s existing Single Leg and Spread Order Entry Forms to create and save custom 
Order Entry Forms that better serve your needs throughout the trading day.

Embedded Order Entry Form

There are three ways in which you can add an Order Entry Form to an Eze EMS window:

 1. Press F7 on your keyboard.

 2. Right-click the window, select Show Windows, and select Order Entry Screen.

 3. From the window’s menu, select Show Windows, and select Order Entry Screen (e.g., Watchlist 
Minder > Show Windows > Order Entry Screen).

Note: You can hide the Order Entry Form at any time by repeating one of the above options.

For example, the Watchlist window with an embedded Order Entry Form is shown below.
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To change the type of Order Entry Form, right-click the Order Entry Form or click the arrow ( ) and 
select System Order Forms, and then select the type of Order Entry Form you would like to use.

When you have custom Order Entry Forms configured, you can select them by navigating to Custom 
Order Forms and selecting the custom form you would like to use.

Pop-up Order Entry Form

In most windows, you can access the pop-up Order Entry Forms by double-clicking on the window. In 
Market Minder windows, you must configure your Double Click Action to open an Order Entry Form.

To configure the double click action in Market Minder:

 1. Right-click your Market Minder window (i.e., Order Blotter, Watch List, Pairs Blotter), or press F4 
on your keyboard. The Minder Setup window appears.

 2. Click the Miscellaneous tab and choose Popup Order Entry from the Double Click Action drop-
down list, and then click OK, as shown below.

You can also customize which type of pop-up Order Entry Form appears by default in your Eze EMS.
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To customize a default type of pop-up Order Entry Form:

 1. Click the Miscellaneous tab in the Order Entry Properties window (Trading > Order Entry Prop-
erties… > Miscellaneous).             

 2. From the Default Order Entry Popup Form drop-down list, select the type of pop-up Order Entry 
Form you would like to set as default and click OK, as shown below.             

Custom Order Entry Form

You can customize both embedded and pop-up Order Entry Forms in your Eze EMS.

To create a custom Order Entry Form:

 1. Open an embedded or pop-up Order Entry Form and choose the type of System Order Form that 
is closest to your needs.
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 2. Right-click the Order Entry Form and select Turn Edit Mode on. Your Order Entry Form appears in 
Edit Mode, as shown below.             

 3. In Edit Mode, you can move controls around by clicking and dragging them. To add new controls, 
right-click the Order Entry Form, click Add Controls, and select the control you would like to add. 
To delete controls, select them and click Delete on your keyboard. 

 4. When you are done customizing the controls, right-click the Order Entry Form and select Reorder 
Controls. The Reorder Order Entry Controls window appears. Select a control and use the Move 
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Up and Move Down buttons to set your desired tab order, and then click OK, as shown below.             

 5. Right-click the Order Entry Form and select Turn off Edit Mode. When the Would you like to save 
your changes? message appears, click Yes.             

 6. Enter a unique name for your new Order Entry Form in the Save Order Form window and click 
Save.            
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Create Ticket Form
Create Ticket Forms appear as pop-up windows in your Eze EMS that are accessed through the Trading 
menu. They are not associated with any other window or trade. The following Create Ticket Forms are 
available in your Eze EMS:

 l Staged Order Ticket

 l Standard Order Ticket

 l Bond Order Ticket

 l Bracket Order Ticket

 l Cross Order Ticket

In addition, if your system is configured to run Eze EMS in OMS mode, the EMS/OMS Integration Staged 
Order Form is available providing a more streamlined option to the EMS Staged Order Form.

Note: To access the EMS/OMS Integration Staged Order Form, your system must be 
permissioned to run Eze EMS in OMS Mode. For additional assistance, contact your SS&C Eze 
client service representative.

Using Create Ticket Forms

To open a create Ticket Form:

 1. Click the Trading menu, select Create Ticket Form, and select the type of form you would like to 
use.             

 2. If the Select Account window appears, choose the account you would like to use and click OK.             

 3. Enter the required order information and click the appropriate execution button (i.e., Buy, Sell, 
Place Orders) to execute the order.            

To enable the EMS/OMS integrated staged Order Form:

 1. Click the Trading menu, select Order Entry Properties, and click the OMS Settings tab.

 2. Select EMS/OMS Integration from the Staged Order Form (Requires Restart) drop-down list, as 
shown below. 
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When this setting is configured and you select Staged Order Ticket from the Create Ticket Form menu 
(Trading > Create Ticket Form > Staged Order Ticket), the EMS/OMS Integration Staged Order Form 
opens, as shown below.
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Order Entry Default Rules
You can specify default values for your Order Entry Forms and Create Ticket Forms using the Order Entry 
Default Rules tab of the Order Entry Properties window (Trading > Order Entry Properties> Order Entry 
Default Rules). Once the default values are configured, your order forms automatically populate with the 
corresponding information, allowing you to save time when entering orders.

Note: Additional order form settings can be customized using the various tabs in the Order 
Entry Properties window.

Creating Order Entry Default Rules

To add a new rule:

 1. Navigate to the Order Entry Default Rules tab of the Order Entry Properties window and click 
New…, as shown below.             

 2. In the Edit Rule window, as shown below, enter a unique name for your rule in the Rule Descrip-
tion field.
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 3. Select whether you would like the rule to be Rule-based or applied to a Symbol List.
 1. If Rule-based is selected, make the following selections:

 l  Security Types – Defines the types of securities the rule applies to. Select <ALL> to 
apply the rule to all security types or select specific types from the list.

 l Exchanges – Defines the exchanges the rule applies to. Select <All Exchanges> to 
apply the rule to all exchanges. To choose specific exchanges, click Select…, select 
the specific exchanges you would like to use from the Available Exchanges list, click 
Add >, and then click OK. 

 2. If Symbol List is selected, enter the symbols you would like the rule to be applied to and 
click Add.

 4. Click OK once you are done configuring the rule.

Note: You can edit these settings at any time by selecting the rule in the Order Entry Default 
Rules tab of the Order Entry Properties window and clicking Edit….

 5. In the Defaults for Selected Rule pane, configure the default values you would like to apply to 
your new rule, and then click OK.
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MarketMaker
The MarketMaker window displays market activity for a selected symbol, including Level 2 quotes, 
regional quotes, trade events, and order position in the market queue. You can use the MarketMaker 
window to:

 l Enter, modify, and cancel orders.

 l View consolidated order books.

 l Use interactive books for orders.

Using the MarketMaker Window

To create a MarketMaker window:

 1. Click MarketMakers on the Design menu. The Market Maker / Regional Setup window appears.

 2. Type a symbol in the Symbol field and select Auto-Detect, Market Depth/Level 2 Quotes, or 
Regional Exchange Quotes, as shown below.

 3. Select the User Interface Settings tab. In the Column Settings pane, select the columns you would 
like to appear in your MarketMaker window, as shown below.

 4. Select the additional settings you would like to add in the Order Entry Properties pane.
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Note: When the My Orders Only checkbox is selected, the position of your live orders in the 
market is displayed and your MarketMaker subscribes to all order updates for a given symbol 
and trade account. When the Show Other User’s Trader ID checkbox is selected, Algo and 
Cash orders claimed by other users at your firm appear in the MarketMaker window with a 
Name value set to that user’s username.

 5. Enter a name for your MarketMaker window in the Window Title field of the Miscellaneous tab.

 6. Click OK.

To add windows to your MarketMaker display:

 1. Right-click anywhere in the Standard Depth View of the MarketMaker window.

 2. Select Show Window....

 3. Select or deselect the windows you want to display.

To enter orders in your MarketMaker window:

 1. Enter the symbol in the MultiQuote window.

 2. On your Order Entry Form, shown below, enter the amount you want to order in the Quantity 
field.

 3. The default order is LMT. If you are placing an LMT order, select the price from the Standard 
Depth View. The Price field automatically populates the price details of the symbol.

 4. If you are placing an MKT order, select MKT from the drop-down list. The price field is auto-
matically disabled.

 5. Once you have entered complete order information, click Buy or Sell to execute the order.

Linking  List Trader to MarketMaker

You can link a List Trader window to a MarketMaker window so that when you select the leg of a staged 
order spread in the List Trader window, the staged spread legs automatically appear in the linked 

Eze EMS Quick Start Guide | © 2022 Eze Castle Software, LLC. Page 103 of 146



MarketMaker Ticket symbol field. You can also select the staged spread legs from the MarketMaker 
ticket list.

To link the List Trader window to your MarketMaker window:

 1. Right-click the List Trader window you want to use and select Links.... The Select Window to Link 
dialog box appears.

 2. Select the MarketMaker window you would like to link to.

 3. Click OK.
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MarketMinder
The Market Minder provides various blotters and views to show you your staged, pair, and standard 
orders as well as positions within the market. You can use the Market Minder to:

 l Stage trades coming from other platforms (e.g., Eze OMS).

 l Upload orders from a spreadsheet (e.g., Microsoft Excel®).

 l Upload orders from an API (e.g., Eze EMS xAPI).

 l Split orders across brokers.

The different blotters and views available for the Market Minder are:

 l Watchlist

 l List Trader/TicketMinder

 l Account Balances Minder

 l BasketMinder

 l Options Risk Minder

 l Order Blotter

 l Aggregated Order Blotter

 l Pairs Blotter

 l Position Blotter

 l Aggregated Position Blotter

 l Regional Quotes Minder

 l ChainMinder

Accessing the Market Minder

To access Market Minder:
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 1. Click Market Minder on the Design menu. The Minder Setup window appears, as shown below.

 2. Select the type of window you want to open from the Minder Type drop-down list.

 3. In the Selected Symbols field, type the symbol you would like to watch and click Add.

 4. Click the Miscellaneous tab and enter a name for your new Market Minder window in the Win-
dow Title field, as shown below.
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 5. Customize the settings you would like to apply to your window and click OK.
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Order Blotter

The Order Blotter displays staged orders that have either been created in Eze EMS or sent from other 
systems via FIX (e.g., Eze OMS), an API, or an uploaded Excel spreadsheet.

You can send orders from your order blotter by:

 l Right-clicking on the bottom panel and selecting Create Single Ticket, as shown below.

 l Using the Create Buy or Create Sell buttons at the button of the screen to create quick orders, as 
shown below.

There are a variety of ways for you to filter the orders in your Order Blotter. You can set filters in the 
Minder Setup window, by right-clicking on your Order Blotter window and selecting Setup Filter…, or by 
pressing the F9 button on your keyboard.

Creating an Order Blotter

To create an order blotter:

 1. Click Market Minder on the Design menu.

 2. Select Order Blotter from the Minder Type drop-down list.

 3. Select the Miscellaneous tab and enter a name for the blotter in the Window Title field.

 4. Click OK.

 5. If the Select Account window appears, select the you would like to use and click OK.

List Trading

List Trading within the Eze EMS gives you the ability to handle multiple orders simultaneously. The orders 
found on a list are either entered directly in the Eze EMS or are imported from another system (e.g., Eze 
OMS) via FIX, an API, or an uploaded Excel spreadsheet. The Market Minder List Trader option allows you 
to view a list of grouped parent orders in a blotter. From the List Trader window, you can:

 l Use the List Creation Manager (LCM) to enter single or multiple orders.             

 l Create exchange supported calendar spreads for futures contracts.             

 l Cross a Buy order and Sell order of the same symbol.             
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 l Cross any number of Buy and Sell orders of different symbols.             

In addition, if your system is configured with Eze EMS/OMS Auto Trade Sync, the two interfaces are 
connected, so if you highlight a trade on the Eze OMS Trade Blotter, the corresponding parent order is 
highlighted on the Eze EMS List Trader. Similarly, highlighting a parent order on the Eze EMS List Trader 
highlights the corresponding trade in the active Eze OMS blotter.

Using List Trader

To create a list:

 1. Click Market Minder on the Design menu.

 2. In the Minder Setup window, select TicketMinder / ListTrader from the Minder Type drop-down 
list.

 3. Select the Miscellaneous tab and enter a name for the blotter in the Window Title field.

 4. Click OK.

 5. If the Select Account window appears, select the account you would like to use and click OK. 

 6. In the List Trader window, click New..., as shown below.
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 7. In the List Creation Manager window, select the Order Tag checkbox and choose the order tag 
from the drop-down list, as shown below. 

 8. Enter the orders to be included in the list in the table below or click Load List to import a list of 
orders.

 9. Click OK

Note: You can also access the List Creation Manager by right-clicking on the List Trader 
window and selecting Create List… from the Staged Orders / Lists menu.

To customize your list trader settings:

 1. Right-click the List Trader window. Choose Staged Orders / Lists > List Trader Settings…. The List 
Trading Preferences window appears, as shown below.
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 2. Configure the settings you would like to apply to your list and click OK.

To cross orders:

 1. In your List Trader window, select the Buy and Sell orders you would like to cross.                 

 2. Right-click the selected orders and select Cross Orders…. The Bulk Cross window appears when 
you select Cross Orders… for multiple orders, as shown below.             
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 3. In the Bulk Cross window, enter the following:             

 l Cross Type – The type of order cross being performed.             

 l Route – The execution route through which the order(s) are sent.             

 l Broker Code – The broker code to which the order(s) are sent.             

 l Crossing Account – The crossing account to which the order(s) are assigned.             

 l Message – (optional) A message that is included with the order.             

 4. Click Cross. The Confirm Bulk Cross window appears, as shown below.             

This window displays a summary, by Symbol, of all the order pairs that are eligible for crossing.

 5. Click OK. All crossed orders are updated with an Order Tag of Bulk Cross in the List Trader gird.             

Note: Only market orders and orders with available free quantity are eligible for Bulk Cross. 
Other order types (e.g., Limit Orders) and working orders in the market are ignored.

Pairs Trading

Eze EMS supports three types of pairs trades:

 l Ratio staged pairs

 l Risk Arb staged pairs

 l Relative Value staged pairs

You can stage pairs with any OMS that certifies trades, or you can create them manually in your Eze EMS 
using the Staged Pairs Order form.

To support pairs trading, Eze EMS offers the Pairs Blotter option in Market Minder and the trading pairs 
tab view (Pairs > Pairs Trader).
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Using the Pairs Blotter

To create a pairs blotter:

 1. Click Market Minder on the Design menu.

 2. In the Minder Setup window, select Pairs Blotter from the Minder Type drop-down list.

 3. Click the Miscellaneous tab and enter a name for your Pairs Blotter in the Window Title field.           

 4. Click OK.

 5. On your Pairs Blotter toolbar, click New… to import pairs.

 6. Select the pairs you would like to import and click Open. The Staged Pair Creation Manager win-
dow appears, as shown below.        

 7. Click Load Pairs… to import more pairs. Click OK to send your imported pairs.
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TurboOptions
The TurboOptions window displays all available options for a given security. You can use the 
TurboOptions window to place an individual options order or spread orders using single- and multi-
legged strategies.

The TurboOptions window includes:

 l A single dashboard view of options chain, including bid/ask prices and strike prices.

 l Internal calculations for Volatility and Greeks.

 l An embedded Order Entry Form.

Within the TurboOptions window, all available options are sorted by expiration date while Put and Calls 
are displayed in a symmetrical view, as shown below.

In addition to the Main View, shown above, you can configure the TurboOptions window to display the 
following panes:

 l Filter View — Automatically enabled when you open a TurboOptions window. Filter View provides 
filter parameters for options, allowing you to narrow down the amount of options being viewed at 
one time.

 l Spread View — This view displays the ISE Spread Book, EUX Spread Book, or spreads generated 
internally in the Eze EMS.

Note: For US options, spreads/strategies are exchange supported. Eze EMS sends the legs to 
the broker and the broker then sends it onto the exchange as a spread. Exchange-supported 
spreads guarantee the leg risk and are less risky than using Eze EMS managed spreads.

 l Account View — You can use this view to select user accounts. It is available in all Eze EMS win-
dows.

 l Regional View — This view displays Level 2 quotes for a selected option.
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Using TurboOptions

To create a TurboOptions window:

 1. Click TurboOptions® on the Design menu. The Setup TurboOptions® window appears.

 2. In the Underlier/Root field, enter the option root or underlier symbol you would like to use and 
select the Straight Options checkbox, as shown below.

Note: When the Straight Options checkbox is selected, the Adjusted Options checkbox is 
automatically selected as well.

 3. Configure the other settings as necessary and click OK.

To create a Multi-Leg TurboOptions window:
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 1. Open the Setup TurboOptions® window.

 2. In the Underlier/Root field, enter the option root or underlier symbol you would like to use and 
select the Multi Exchange Options checkbox.

 3. Select the Straight Options or Mini Options checkbox to determine the option type.

 4. Click OK

To add views to your TurboOptions window:

 1. Right-click your TurboOptions window and choose Show Windows….

 2. Select the window you would like to add from the sub-menu.

To enter an order from your TurboOptions window:

 1. Open the Order Entry Form by:
 l Right-click your TurboOptions window and select Order View from the Show Windows… 

menu.

 l Select Order View from the TurboOptions® menu.

 l Press F7 on your keyboard.

 2. Enter the necessary information.

 3. Click Buy or Sell to execute the order.

Using Filter View

Filter view is automatically enabled when you create a TurboOptions window. You can choose to show or 
hide the Filter View by selecting or deselecting it in the Show Windows… menu or by pressing F10 on 
your keyboard.

The following filters are available:

 l Months — The number of months to be displayed. This also applies to weekly options.

 l Strikes — Displays a range of options around an “at the money” strike price, a set of options whose 
strike price is within a specified range, a single strike price, or all available options for a given num-
ber of months.

 l Options Expiry Buttons — Displays a particular expiration date. Multiple expiration dates can be 
chosen by selecting one Expiry Button and then holding the Ctrl key while you make the other 
selections.

Click the More>> button to select additional filters, such as a specific options style and additional 
expiration dates.
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MultiQuote
The MultiQuote window is a versatile quote window that displays Level 1 symbol data and account 
information by default. It is used for a single instrument or a single trading account.

Different layouts for the MultiQuote window offer a wide range of information, including fundamental 
data, price data, and account (margin) information. In addition, you can customize and add fields to the 
MultiQuote window, as well as embed it in most Eze EMS windows (e.g., MarketMaker or TabView).

Creating a MultiQuote Window

To create a MultiQuote window:

 1. Click MultiQuote on the Design menu. The MultiQuote Setup window appears, as shown below.

 2. Customize the settings as desired and click OK.

To edit the MultiQuote window:
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You can use Edit Mode to customize your MultiQuote window. Access Edit Mode in one of the following 
ways:

 l Right-click your MultiQuote window and select Edit Mode.

 l On the top ribbon, click the MultiQuote menu and select Edit Mode.

 l Press F5 on your keyboard.

When in Edit Mode, your MultiQuote window appears as shown below:

In Edit Mode, you can:

 l Click and drag each field to change its position in the window.

 l Double-click a field to change its properties.

 l Right-click the MultiQuote window, select Edit Actions…, and select an editing option from the 
menu (e.g., Insert Data Field, Insert Text, Insert Candlestick).

When you are done, exit Edit Mode by repeating any of the steps used to access it.
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Basket Orders
A basket order is a group of securities brought together with the intention of being bought or sold all at 
once. You can use the Eze EMS List Trader to create Basket Orders.

Note: For more information on creating and using the Eze EMS List Trader, refer to the List 
Trader section of this guide.

Creating Basket Orders

To create a basket order:

 1. Import staged orders to your List Trader blotter using the List Creation Manager.

 2. On your List Trader blotter, select the orders you would like to include in your basket and click 
Order Settings.... The Edit List Trading Parameters window appears, as shown below.

 3. Customize the settings as necessary. Click Set Values to save the settings and return to the List 
Trader blotter or click Execute Now to send the Basket Order to the market.

To save a basket order:

 1. Click Save Basket on the List Trader menu.

 2. Type the name of the basket in the File name field.

 3. Click Save.

To load a basket:

 1. Click Load Basket on the List Trader menu.

 2. Click or type the name of the basket in the File name field.

 3. Click Open.

To execute a basket:
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 1. Type the name of the basket in the Basket Tag field.

 2. To buy/sell the specified quantity of baskets based purely on the weights, click the Delta option 
button.

 3. Type or select a multiple of the weight or, to use your current position to determine how much to 
buy/sell, click the Target option button.

Note: The Target model targets the number of shares you wish to own of a specific stock. It 
looks at your current position of the number of shares you already own, and then buys/sells 
accordingly.
For example, your weight is 100 for MSFT, and you currently have 150 shares of MSFT.  If you 
choose a Target of 1, the system will sell 50 shares to equal the 100-share weight for MSFT. 

 4. The Delta model is a multiplier of the weight.  It purchases or sells based on the weight of a sym-
bol, regardless of your current position.

 5. Type or select the number of baskets you wish to own.

 6. Click Recalculate and then click Execute Basket.
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Configuration Files
Configuration files allow you to customize certain behaviors within your Eze EMS. They are created in the 
Configuration Files tab of the Order Entry Properties window (Trading > Order Entry Properties > 
Configuration Files), shown below.

Creating Configuration Files

To create a configuration file:

 1. Write and save a .ini file to the Trading folder with the appropriate configuration information.

 2. In the Configuration Files tab of the Order Entry Properties window, click the three dots next to 
the appropriate field name (e.g., Broker Codes, Client Account, Portfolio Strategy Mapping).

 3. Select your .ini file from the Configuration Files window and click Open.

Note: Contact your SS&C Eze client service representative for more information regarding 
your Eze EMS .ini configuration files
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Hot Buttons
In Eze EMS, you can configure your MarketMaker, Market Minder, and TurboOptions windows with a 
toolbar of hot buttons that coordinate to your existing order entry actions. When this toolbar is created, 
you can click a hot button and Eze EMS performs the specified action.

Adding Hot Buttons

Before you can add hot buttons to your Eze EMS, you must create a toolbar for the buttons to be 
accessible from.

To create a toolbar:

 1. Open the Toolbar Configuration window by doing one of the following:
 l Right-click your MarketMaker, Market Minder, or TurboOptions window, select Show Tool-

bars, select New Toolbar…, and then select either a Dynamic Toolbar… or a Standard Tool-
bar….

 l Click the MarketMaker, Market Minder, or TurboOptions® menu, select Show Toolbars…, 
select New Toolbar…, and then select either a Dynamic Toolbar… or a Standard Toolbar….

Note: You can return to the Toolbar Configuration window at any time by right-clicking on 
your toolbar and selecting Configure Toolbar….
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 2. In the Toolbar Name field, enter a unique name for your toolbar.

 3. If you already have hot buttons configured, they appear in the Available Actions pane. Select the 
hot buttons you would like to add to your toolbar and click Add to move them to the Selected 
Actions pane. Use the Move Up and Move Down buttons to change the order of buttons in the 
Selected Actions pane.

 4. Customize the additional settings as necessary and click OK. Your new toolbar now appears on 
your window (i.e., MarketMaker, Market Minder, or TurboOptions).

To create an order action hot button:

 1. Right-click your MarketMaker, Market Minder, or TurboOptions window. Select Show Toolbars 
and choose an existing toolbar or select New Toolbar….

 2. Right-click the toolbar and select Inset New Button… or Add New Button…, and then select Order 
Action. The New/Edit Action window appears, as shown below.

 3. Configure the settings as necessary and click OK.

Note: You can customize the name of the hot button. To customize the name, clear the Auto 
check box in the Description pane and enter your desired name.
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 4. In the New Action Filename window, specify a unique file name.

 5. Click OK. Your new hot button now appears on your toolbar.

To create a list trading order action hot button:

 1. Right-click your MarketMaker, Market Minder, or TurboOptions window or select the Mar-
ketMaker, Market Minder, or TurboOptions® menu from the top ribbon. Select Show Toolbars 
and choose an existing toolbar or select New Toolbar….

 2. Right-click the toolbar, select Inset New Button… or Add New Button…, and then select List Trad-
ing Order Action. The Edit List Trading Action window appears, as shown below.

 3. Configure the settings as necessary and click OK.
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Canceling Orders
You can cancel orders in Eze EMS before they have been filled. This includes the remainder of an order 
that has not been filled, or the entire order if it has not been filled.

There are a variety of ways to cancel orders within Eze EMS. However, the following outlines the most 
common order cancelation workflow.

To cancel an order:

 1. In your Order Blotter, select the order you would like to cancel.

 2. Right-click the order and select Cancel Order.
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Advanced Order Types
Order types determine the prices and conditions under which an order is filled. Some of the more 
common order types previously covered in this guide include Basket, Bracket and Order Cancel Orders.

Other order types available in Eze EMS include:

BBO (Best Bid Offer)
Similar to a market order, this order type sets the limit price at whatever the 
other side of the market is currently at.

Conditional Order
Allows you to specify conditions which signal for an order to be made. Condi-
tional orders are held on your computer while waiting for an execution price 
instead of being sent to the market immediately.

Note: You must be signed into Eze EMS for a conditional order to be executed.

Discretionary Order
Gives the broker the authority to determine how to break up an order 
between the price to execute at and the order volume to place.

MID
Allows you to set a limit order with a price at the midpoint of a security’s cur-
rent spread.

Pegged Order

Allows you to set a limit for the worst price you are willing to accept between 
the bid and the ask. From here, you are given a BBO order that moves with the 
side of the market you are on (i.e., bid if buy; ask if sell). If the BBO order is not 
taken before the limit price is reached, the limit order is executed and closes 
out the pegged order.

Reserve Order

Allows you to buy or sell a security in increments so that the whole amount 
traded is not exposed to the market. This is like a staged order, except the 
ticket is given to a single broker instead of being split between multiple 
brokers, as with a staged order.

In addition, the following order types are only available when trading through the ARCA exchange:

Preference Order Allows you to choose a specific market maker to fill your order.

PostNoPref The order is traded on ARCA’s book without routing.

Trailing Stop Order

This is a type of stop order set at a defined percentage or offset away from a 
security’s current market price. If the value of the security to the investor 
drops by that percentage on the day, a trade is executed to close out that pos-
ition.
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Routing Orders
There are several different ways to route your orders through Eze EMS. This section explains the 
following route types:

 l Algorithmic-Based Order Routing

 l Routing to External Crossing Networks

 l Broker Algo Wheels

 l RBOR (Rules Based Order Routing)

Algorithmic-Based Order Routing
You can create algorithms to be executed in Eze EMS using the Eze EMS API and Eze EMS for Excel. 
Configure and save an algorithm in the Eze EMS API or Eze EMS for Excel and select it from the Strategy 
drop-down list on the Order Entry Form when executing trades.

When an algorithm is executed, it checks its configured parameters against Eze EMS’s market data. 
When the variables of a trade fit the algorithm’s criteria, Eze EMS or its API executes the trades as 
directed by the algorithm.

Eze EMS also supports trading through a wide variety of brokers’ algorithmic trading engines. To support 
this functionality, your system can be configured with different broker algo routes that execute broker 
designed algorithms on the market when selected.

When you send an order over a broker algo route, a pop-up window appears in Eze EMS associated with 
that specific route. Use this window to set the parameters for the algorithm and specify how you want 
the algorithm to operate on the market conditions it encounters.

Note: Contact your SS&C Eze client service representative to enable this functionality.

Routing to External Crossing Networks
Eze EMS can be configured so that orders staged in Eze EMS are automatically sent to selected external 
crossing networks for execution as Day (conditional) orders while remaining live and available for 
commitment to other brokers on the Eze EMS blotter.

The external crossing networks currently available for integration with Eze EMS are:

 l BIDS

 l BlockCross

 l LiquidNet

 l Luminex

 l POSIT
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If you route a portion of a staged order to a broker, Eze EMS automatically sends an update to the 
corresponding external cross network to decrease the quantity of the Day order by the amount that you 
route to the broker.

Note: If your system is configured with both Eze OMS and Eze EMS, you can stage orders 
from Eze OMS to Eze EMS that are sent to external crossing networks.
In addition, if your system is configured to use Eze Compliance, the system does not re-run 
compliance checks for child orders you firm up with an external cross network.

Note: All external cross networks accept both Market and Limit orders with a Side of Buy, Sell, 
or Sell Short.
Eze EMS automatically sends GTC orders marked as cross eligible to the selected external 
cross network(s) on a recurring basis (as Day orders).

Using External Crossing Networks

Configuring a Default External Crossing Network

To configure a default external crossing network:

 1. Navigate to Trading > Order Entry Properties and select the Miscellaneous tab.

 2. Select the external cross network(s) you would like to use from the Default External Cross Net-
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works pane and set the Max Shares Limit, as shown below.

 3. Click OK. When you have external crossing networks selected, the corresponding checkboxes 
appear and are automatically selected in the External Cross Networks field of your Submit Staged 
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Order form, as shown below.

The external crossing networks are also available via the Ext. Cross drop-down list in the List Creation 
Manager, as shown below.

In addition, you can select external cross networks after an order has been staged by right-clicking on the 
order and selecting Select External Cross Networks…. In the Select External Cross Networks window, you 
can select your Crossing Networks and specify the Max Shares Limit to be exposed.
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Note: Max Shares Limit is the only editable field for a selected crossing network. Its value 
should be greater than or equal to Firm Shares.

Note: You can add the Cross Max Vol column to EMS blotters to view the maximum number 
of shares exposed to external cross networks for an order.

Sending from the Parent Level of a Pairs Order

If your system is integrated with an external cross network(s), you can send orders to an external 
crossing network(s) from the parent level of a pairs order.

To send an order from the parent level, right-click the pairs order and select Select External Cross 
Networks… from the shortcut menu.

Note: External crossing networks do not recognize pairs orders. When they receive pairs 
orders, they treat them as single-leg orders.

Sending Grouped Orders

You can group two or more staged orders and manually send the orders to external cross networks. Once 
the orders have been grouped, the staged orders are removed from the cross networks.

To manually send the grouped order to external crossing networks:

 1. Right-click the grouped order and select Select External Cross Networks…. The Select External 
Cross Networks window appears.

 2. Select the desired external cross network(s) and click OK. The external cross networks are 
updated for the grouped order.

Confirming (Firming Up Child Order Executions in External Crossing Networks)

BIDS

If BIDS identifies liquidity for a live order, you need to cancel the existing order manually in Eze EMS 
before you can receive the available amount from BIDS. Once the order is canceled, and you firm up in 
the BIDS interface, BIDS sends a placement request to Eze EMS. If the placement request is accepted, a 
child order is automatically created in Eze EMS.

When the child order is executed, information for the executed order is automatically updated in Eze 
EMS.

BlockCross

BlockCross matches orders on a price, auto execution quantity, top quantity, and time priority. If liquidity 
is identified for a live order, BlockCross sends a placement request to Eze EMS, and you firm up the order 
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in Eze EMS. If the placement request is accepted in Eze EMS, a child order is automatically created.

When the child order is executed, information for the executed order is automatically updated in Eze 
EMS.

LiquidNet

When a potential block of fills is identified as available in LiquidNet, a negotiation window appears in you 
LiquidNet application.

You may pull back an untraded quantity of the order from exposure on the Eze EMS blotter and 
negotiate with LiquidNet. Once the negotiation is complete, a FIX message is sent from LiquidNet to Eze 
EMS to indicate the staged order has been filled.

Luminex

Luminex matches orders on a price, auto execution quantity, top quantity, and time priority. If liquidity is 
identified for a live order, Luminex sends a placement request to Eze EMS, and you firm up the order in 
Eze EMS. If the placement request is accepted in Eze EMS, a child order is automatically created.

When the child order is executed, information for the executed order is automatically updated in Eze 
EMS.

In addition, your system can be configured so that orders routed to Luminex are automatically re-routed 
if the uncommitted order quantity is updated to exceed 5,000.

Note: This functionality can be disabled by deselecting Luminex from the Select External 
Cross Networks window (right-click order(s) > Select External Cross Networks…).

POSIT

If a potential block of liquidity is available in POSIT, a POSIT negotiation window appears in the ITG 
interface. Once you firm up in the POSIT interface, POSIT sends a placement request to Eze EMS. If Eze 
EMS accepts the placement request, a child order is automatically created.

When the child order is executed, information for the executed order is automatically updated in Eze 
EMS.

If potential liquidity is identified by POSIT for committed unfilled orders, POSIT sends a non-actionable 
alert via the ITG POSIT Alert system. EMS users can then manually select the order quantity to send to 
POSIT for crossing.

If you want to cross a committed unfilled order quantity via POSIT, you need to cancel the committed 
quantity of the corresponding order in the EMS to allow the quantity to become eligible to cross in the 
POSIT interface.

You cannot cancel reserve orders from Eze EMS. If you want to cancel an order that has been firmed up 
with POSIT, you must cancel the order from the ITG interface.
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Furthermore, your user ID (claimed by ID) is checked to determine if you are logged into the POSIT 
console. If you are logged into the POSIT console and you claim the order and send it from Eze EMS to 
POSIT, the order is successfully transmitted to the POSIT blotter.

If you are not logged into the POSIT console, and you attempt to claim the order, the order is removed 
from POSIT and you no longer see POSIT in the External Crossing Networks column.
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Broker Algo Wheel
The Broker Algo Wheel feature gives you the ability to execute orders to a pre-defined list of broker 
routes, allowing you to remain focused on trading decisions such as strategy selection and core inputs, 
rather than on broker selection. Algo wheels also help to ensure your orders are routed in an impartial 
manner, reducing broker-selection bias.

Creating a Broker Algo Wheel

Algo wheels are created using broker algo routes and saved strategies. When creating an algo wheel, you 
assign a percentage weighting to each route. You can choose whether you want the algo wheel to 
execute in the order you have configured in your broker list or in a randomized fashion.

To add a Broker Algo Wheel, use the Virtual Routes tab of the Order Entry Properties (OEP) window 
(Trading > Order Entry Properties > Virtual Routes).

Note: Before you can add or configure a Broker Algo Wheel, you must have Virtual Routes 
permissioned for your system. For additional assistance, contact your SS&C Eze client service 
representative. 

To add a broker algo wheel:

 1. Select the Virtual Routes tab and click Add, as shown below. 
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 2. In the New Virtual Route window, enter the following information:    

 l Route Name — A unique name to easily identify the algo wheel.

 l Route Type — This is a read-only field that is automatically populated with Algo Wheel to 
define the type of route.

 l Security Type — The selected security type(s) to be applied to the algo wheel. Default value 
is <ALL>.

 l % Weight Based On — Determines whether your wheel executes based on Orders or Quant-
ity.

 l Order Type — Defines the type of order the algo wheel is applied to. Default value is Single-
leg.

 l Region — Defines the region that the algo wheel is applied to. Default value is <ALL>.

 l Wheel Mode — Determines whether order execution is Probability-based or Rotation

 l Availability  — When Probability-based is selected for Wheel Mode, youcan specify whether 
you would like your algo wheel to execute when any subroute supports the market (When 
ANY subroutes can trade symbol), or if all subroutes must support the market (When ALL 
subroutes can trade symbol).

 3. Click OK.

Note: You can change these settings after creating your wheel by selecting the route name 
and clicking Edit.

Configuring a Broker Algo Wheel 

To configure a broker algo wheel:
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 1. In the Virtual Routes field, select the algo wheel you want to configure. If no subroutes have been 
configured, the algo wheel name appears with a warning icon ( ), as shown below.

 2. In the SubRoute Configurationfield, shown above, add the following information:
 l Account — The name of the broker route.

 l Route — Select name of the broker route. 

 l Strategy — A saved strategy to be used with the route.

 l Weight — The percentage weight you want to assign to each route.

Note: The total percentage of all routes configured for a Broker Algo Wheel must 
equal 100%.

The Order Entry Properties window must be filled in completely before closing. A flag appears next to the 
route name if there is an error or missing information. The algo wheel is not saved when the window is 
closed without completing all fields.

Executing Orders using the Broker Algo Wheel

You can execute orders from your MarketMaker window using an algo wheel. Select Virtual in the Route 
drop-down list and select the name of the algo wheel to which you want to route the order from the 
Strategy drop-down list, as shown below.
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You can also configure a hot button for each Broker Algo Wheel to quickly execute single or multiple 
orders at the same time from your List Trader and MarketMaker windows. To execute an order using a 
hot button, highlight one or more orders in the MarketMaker window and then click the algo wheel hot 
button to route the order.

For information on configuring hot buttons, refer to the Hot Buttons section of this guide.
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RBOR (Rules Based Order Routing)
Rules Based Order Routing (RBOR) allows orders that are either staged into Eze EMS via FIX or API to be 
automatically routed to any available destination based on the parameters of the inbound order. RBOR 
can be used by any buy-side or sell-side firm looking to automate a portion of the order workflow to free 
up trading desk resources and concentrate on high-touch orders.

In addition, RBOR provides the ability to:

 l Create connections to multiple brokers involving multiple strategies.

 l Route orders based off any field included in the order and nest rules (i.e., route-off multiple fields).

 l Cancel orders automatically based on the criteria for one route.

 l Cancel child orders sent to one destination and reroute the orders to another destination based on 
time of day.

 l Create a rule that automatically routes rejected orders to the trading desk as staged orders to be 
worked on by traders instead of back to the client.

Note: Contact your SS&C Eze client service representative to configure RBOR rules in Eze 
EMS.

RBOR Rules

You can create RBOR rules to route based on:

 l Matching a specific field value

 l Matching using traditional logic operators (i.e., <, >, NOT, AND, OR)

 l The presence of a field

 l A percent of average daily volume

 l A percent away from market

 l Notional value

The following are some common RBOR rules:

 l Routing by Time Submitted — For example, if the order is placed between the hours of 9:30am and 
4:30pm EST, send the order to Route A. If the order is placed before or after those times, send the 
order to Route B.

 l Routing by Time in Force (TIF) — For example, if the order is GTD, MOO, or MOC, send it to Route 
A. All other TIFs are sent to Route B.

 l Routing by Volume — For example, if the order is greater than 100,000 shares, leave as a staged 
order in the Neutral Account. Anything under 100,000 shares is routed to a destination.

 l Cancel and Resubmit Logic — For example, if an order is placed out to Route A, but is not fully filled 
by 4:00pm EST, then the order is canceled and sent to Route B.

 l Broker Rejects — For example, if a broker rejects an auto-routed order, then the parent order 
remains in a staged order state. The rejected order is not sent back to the client.
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 l User Message — Instructions to traders to handle the orders in a certain way (e.g., trade APAC 
orders as a VWAP for 2 hours).

 l % ADV — Instructions to trade when the % ADV reaches or goes above a certain point.

RBOR with Algorithms

Within Eze EMS, you can configure RBOR rules to automatically route your orders to a broker algorithm. 
Once an RBOR rule has been created with algo parameters and is in production, it behaves like any other 
RBOR rule and automatically routes the order to the defined destination if the rule’s conditions are met.

Note: Contact your SS&C Eze client service representative to enable this functionality.
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Automated Trading
Eze EMS Automated Trading gives you the ability to create and manage the automated trading rules in 
Eze EMS. This allows you to automate straightforward, highly liquid orders, focus on high-touch trades, 
and more quickly respond to strategy changes and market conditions.

You can use the Automated Trading Rules Manager (Trading > Automated Trading...), central screen to 
add, edit, activate, and deactivate trading rules.

Automated Trading Rules Manager
The Automated Trading Rules Manager screen has multiple sections, as shown below:

Status Message
The status message is to inform you if the rules currently viewed in staging match with the ones in 
production. The following message is displayed at the top of window depending on the state of your 
rules:

 l You are viewing a rule set currently matching production

 l You are viewing a rule set currently not matching production

Rules Filter
The rules filter grid helps you to find automated trading rules by filtering Rules Manager window. This 
section also contains the Preview Conditions checkbox, allowing you to view the conditions of a selected 
rule without  opening the rule in Edit Rule.

Rule Actions
The rule actions grid allows you to create new rules, and edit or take other actions on existing rules. The 
following options are available:
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 l New Rule – Allows you to create a new automated trading rule. Refer to Adding a New Rule section 
for more information.

 l Edit Rule – Allows you to edit rule currently selected in the grid. 

 l More Actions – Allows you to perform one of the following additional actions:
 l Clone – Allows you to duplicate the selected rule.  A New Rule window is displayed with all 

the  informationcloned, only the Name field is blank.

 l Delete – Click to delete the selected rule.

 l Reset –  Allows you to change staging to match current production rule set. This affects all 
rules in Staging.

The following options are available when you view rules in Production:

 l Pause All Rules –  Eze EMS stops using all automated trade rules in production. This button changes 
to Resume Rules while rules are paused. Click Resume Rules to restart the use of enabled auto-
mated trading rules in production.

Note: Any orders that have been automatically routed prior to using the Pause All Rules 
button continue to fill as pausing rule evaluation only affects new orders.

Production Management
The production management section of the window allows you to view created rules, and decide which 
rules to be used in production. 

The rules grid displays the following information on each of the rules, and allows you to switch between 
the Staging and Production rules at the top of the grid. For more information on Staging vs. Production, 
see Managing Staging and Production Rules.

The grid displays the following information:

 l Priority – Indicates the order in which a rule is evaluated for use. Priority can be changed by click-
ing and dragging a rule.

 l Rule Name – Name of the rule as specified during the new rule creation process.

 l Route – Route used when the rule is active.

 l Saved Strategy – Strategy used if an algo route is selected in Route.

 l Enabled – Used to select rule(s) to be used in production. When viewing the Production rules grid 
this is a read-only field.

 l Date Created – Date the rule was created. Displays in MM/DD/YYYY format.

 l Created By – The username of the rule's creator.

Additionally, the grid is organized by the rule's account. Rules applicable to all accounts are listed under 
Global.

When the user views rules in Staging, the following buttons are available below the grid:
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 l Send to Production – When clicked, the rules are moved to production.

 l Save – Saves the current rules' configuration (e.g., rules added to staging, priorities of existing rules 
changed), but does not enable or change the current production rules.

 l Discard Changes – Reverts the Staging rules state to the most recent Save or Send to Production 
configuration.

When the user views rules in Production, this area is blank.

Adding a New Rule
Eze EMS Automated Trading requires at least one created rule. 

To add a new automated trading rule:

 1. Open the Automated Trading Rules Manager (Trading > Automated Trading...).

 2. Click New Rule. The New Rule window appears.

 3. Enter the required information in the Rule Summary section:
 l Rule Name – Required. A unique name to easily identify the rule.

 l Description – Optional. Additional information helpful in identifying the rule or the rule's 
business purpose.

 l Account – Required, default value of <ALL>. A specific account the rule applies to.

 l Customer – Displays only for sell-side clients. When displayed, it is required, with a default 
value of <ALL>. A specific customer the rule applies to.
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 l Security Type – Required, default value of <ALL>. One or more specific securities types the 
rule applies to.

 l Region – Required, default value of <ALL>. One or more specific regions the rule applies to.

 4. In the Rule Conditions section, specify the conditions used to trigger the rule.
 l Use the And/Or selector to choose the condition type to specify.

 l When And is used, all specified conditions must be met for the rule to be triggered.

 l When Or is used, any single condition or group of conditions can trigger a rule.

 l A line item for the first condition already appears.
 l From the dropdown, select the field (e.g., Symbol, Exchange, 20-Day ADV) for the 

rule to reference.

 l Select the operator (e.g., less than, less than or equal to, equals).

 l Enter or select the value for the operator to compare against.

 l To include additional conditions, click New Condition or New Group:
 l Use New Condition to add a condition of the same type (e.g., previous rule was And 

and the new rule is And).

 l Use New Group to add a condition of a different type (e.g., changing from an And 
rule to an Or rule). Each rule group is displayed within a box, with a New Condition 
button (i.e., add a condition within the group), New Group button (i.e., add a group 
within the selected group), and a delete group icon. Rule groups are displayed in the 
following format:

 l To delete a condition or group you have created, click the delete icon ( ).

 l To re-order a rule or a rule group, click the list icon ( ) and drag the rule or rule group as 
required.

 5. Enter the required information in the Rule Action section:
 l Sub Account – Required. The Sub Account to use when the rule is triggered.

 l Route – Required. The broker to route the order to when the rule is triggered.

 l Strategy – Required when an algo route is specified in Route. A strategy to be used when 
the rule is triggered.
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 6. When the rule is configured, click Save. To discard your changes and return to the manager 
screen, click Cancel.

The rule is now added to the Staging rule list.

Managing Staging and Production Rules
Automated trading rules are managed between Staging and Production lists. This allows the user to 
update the rule set without impacting orders until you are ready for all enabled rules to be utilized. 
When a new rule is created, it is added to the Staging list, and is disabled by default. 

To send rules to Production:

 1. In the  Automated Trading Rules Manager (Trading > Automated Trading...), view the staging grid 
and add or edit any rules as necessary.

 2. Click and drag rules as needed to set the rule priority.

 3. Click the Enabled check box for all rules you want Eze EMS to actively use.

 4. To send the rules to production, and make any rules designated as Enabled active, click Send to 
Production.

 l If you want to retain your current rule configuration, but not make it active in production, 
click Save.

Note: Remember: Sending a rule to Production does not necessarily mean it is being 
evaluated by Eze EMS for automated trading. For a rule to be evaluated, the Enabled check 
box must be selected prior to clicking Send to Production.

The only action that can be directly taken on rules in Production, is to pause the rules from use by 
clicking the Pause All Rules button. Any other changes to Production rules must be done by first making 
adjustments in Staging, followed by sending the rules to Production.

Dedicated Automated Trading Blotter Configuration
A dedicated automated trading blotter can be created to more effectively display automated trading 
activity, allowing the user to quickly see Eze EMS Automated Trading orders at a glance.

To configure a dedicated automated trading blotter:

 1. Create a Market Minder. Select ListTrader from the Minder Type dropdown. 

 2. Click OK. The blotter is created.

 3. Open Order Filtering Setup (MarketMinder > Setup Filter)

 4. Select Turn order filtering on.

 5. From the Available Filters, select Auto Routed Order and click Add >. Then, select Curr Status and 
click Add >.

 6. Select the Seperate Staged/Live Statuses check box.

 7. Click OK.
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The blotter is now configured to display only automated orders.

Additionally, a new field, Automated Trading Rule Name, has been added to Eze EMS. This field can be 
displayed as a column on the child order level, allowing the user to see the name of the automated 
trading rule executing the child order, as shown below.

For more information on supported functions, see Appendix A: Use Case for Automated Trading.

Appendix A: Use Case for Automated Trading
The following use case illustrates how the automated trading functionality can be used.

You want to create a rule that automatically:

 l Routes to Credit Suisse using their VWAP strategy.

 l Applies to all accounts, customers, and security types, but only to securities in North America.

 l Applies if the notional amount is less than or equal to 500,000 USD, if the quantity less than or 
equal to 5000, and the 20 Day Average is less than or equal to 2% (as to ensure this automated 
action does not move the market).

 l Uses your VWAP strategy already configured for North America.

To do this, you create an automated trade rule with the following parameters:

 l Rule Name: CS_VWAP

 l Description: Credit Suisse Automated VWAP for North America

 l Account: <ALL>

 l Customer: <ALL>

 l Security Type: <ALL>

 l Region: NAMR

 l Rule Conditions:
 l | Notional | | is less than or equal to | | 500000 | | USD |

 l | QTY | | is less than or equal to | | 5000 |
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 l | 20-Day ADV | | is less than or equal to | | 2% |

 l l Sub Account: SUB.ACCOUNT

 l Route: CSAES-NA

 l Strategy: VWAP_US

With the rule added and saved, you drag the rule to be the first in priority and designate this rule as the 
only enabled rule. You then click Send to Production. Now you close the window and start trading. In the 
List Creation Manager, you load a list with the following data:

Symbol Quantity Limit Price Side

AAPL 10,000  Buy

JPM 20,000 90.94 Buy

VOD.LSE 10,000  Buy

BMW.ETR 3,000 48.59 Buy

TSLA 1,000 729.22 Buy

AIQ 3,000 16.91 Buy

MSFT 1,500 173.45 Sell

GE 3,000 6.42 Buy

 

Of the items in list loaded into Eze EMS: 

 l AAPL and JPM exceed the quantity condition in the rule, and are excluded from automated trading.

 l VOD.LSE and BMW.ETR are non-North American, and are excluded from automated trading based 
on the region condition.

 l TSLA, at 1,000 for 729.22 USD has a notional amount of $729,220, exceeding our notional con-
dition in the rule, and is excluded from automated trading.

 l AIQ is an illiquid stock, not meeting the 20-Day ADV condition in the rule, and is excluded from trad-
ing.

 l MSFT and GE meet all conditions of the specified rule.

Once the trade goes live, you see MSFT and GE routed to Credit Suisse automatically per the rule's 
actions.
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